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                                                                  CHAPTER-I   

INTRODUCTION :-   

                      The Ultrasonic velocity determined by the interferometer method is considered as 

more reliable and precise as compared to other methods. In many industrial applications, rather 

than single component liquid system, liquid mixtures are used in processing and product 

formulations ( V.D. Bhandhakkar et al 2014) .The significance of volumetric, acoustic and 

thermodynamic studies in mixtures have been used for understanding the intermolecular 

interactions for interpreting different types of interactions .This method find extensive 

applications for characterizing aspects of physicochemical behaviour such as the nature of 

molecular interactions in pure liquid as well as liquid mixtures (S.Thirumaran et al) . Ultrasonic 

velocity is one of the important parameters frequently used to investigate intermolecular 

interactions in binary liquid mixtures (Shaik babu et al 2011). Now -a- days ultrasonic is used in 

area of intense scientific and technological research. Thermo-acoustic parameters are the 

essential sources of information for better understanding of non-ideal behaviours of complex 

binary liquid system (J.N. Ramteke et al,2014). Ultrasonic measurements are very useful in 

chemical, food processing, pharmaceuticals material testing and underwater ranging and cleaning 

and they are commonly employed in mechanical machinery of materials, preparation of colloids 

or emulsions, imaging of biological tissues etc... (Sk. Md Nayeem et al, 2014). Ultrasonic studies 

in polymeric solutions have drawn the attention of many researches in the recent years. This 

method is a powerful and effective tool for investigation of polymer solutions and behaviour of 

polymer chain in an ultrasonic field (S.S. Kulkarani et al,2012). Ultrasonic propagation 

parameters provides valuable information regarding the behaviour of binary liquid systems, 

because intramolecular association, dipolar interactions, complex formation and related 

structural changes affect the compressibility of the system which in turn produces corresponding 

variations in the ultrasonic velocity (P. Paul Divakar et al, 2012). The study of intermolecular 

interactions play an important role in the development of molecular sciences .The development 

of liquid state theories was quite retarted compared to the theories of gases state and solid state 

.However ,during the last forty years there has been a considerable importance and a number 

experimental techniques have been used to investigate the interactions between the components 

of binary liquid mixtures .It is obvious that the study of excess compressibility and excess molar 

volume gives important information on intermolecular forces existing in binary liquid 

mixtures(B. Sathyanarayana et al, 2006). Ultrasonic velocity and density data can be used to 

investigate the solute- solute interaction using statistical theory solutions. Measurement of 

physiochemical properties such as density and ultrasonic velocity of pure components and their 

binary mixtures are being increasingly used as tools for investigation of the pure components and 

the nature of intermolecular interactions between the components of liquid mixtures (J.N. 

Ramteke et al, 2014). The liquid state theory should be in a position to explain the 

thermodynamic behaviour of simple liquids, equilibrium and transport properties of liquids and 

results of x-rays and neutron diffraction techniques. It has been pointed out by several workers 

that this ultrasonic technique has been adequately employed to investigate the properties of any  
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substance to understand the nature of molecular interactions in pure liquids (S. Mullainathan et 

al, 2010).  

                        Taking into account, the varied applications of ultrasonic studies we have 

designed this project using Ethyl propionate with curcumin to carry out the acoustical study of 

parameters. Ethyl propionate appears as a clear colorless liquid with a pineapple-like odor. It is a 

propanoate ester of ethanol. It has a role as a metabolite.  It is used in perfumery and fragrance. It 

is used to manufacture various propionates which used in the reduction of pharmaceuticals, 

antifungal agents, agrochemicals, plastics, plasticizers, rubber chemicals, dyes, artificial flavors 

and perfumery synthetics. It is used also as a solvent and in nickel-electroplating solutions 

(PubChem release 2021).   

                         Curcumin is a natural yellow dye derived from the rhizome of Curcuma Longa 

Linn. It is responsible for the most of the therapeutic effects of turmeric used widely as a food 

colouring.  It is best known for the Ayurvedic medicine for centuries on the Indian subcontinents 

a pharamacological safety drug because of it’ s antioxidant and antiflammatory effects (R. 

Soundar et al, 2021).  By considering the utility of above two given solutions that is Ethyl 

propionate and curcumin, we have chosen these two solutions as the experimental mixture for 

the acoustical studies.   

Objectives:   

        Taking into account the significant reasons for the study of acoustic parameters, the project 

was carried out with the following objectives.   

1. To determine the ultrasonic velocity of the experimental mixtures of different 

concentrations.   

2. To determine the density of the experimental mixtures.   

3. To determine the coefficient of viscosity of the experimental  mixtures.   

4. To calculate the values of derived parameters such as Adiabatic compressibility (β),   

Free length (L), Relaxation time (ι), Acoustic impedance (Z) and Ultrasonic 

attenuation (α/f2)  
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                                               CHAPTER-II  

 REVIEW OF LITERATURE:  

                 Mr. S. Thirumaran et al (2010) have studied the ultrasonic velocity, density, viscosity. 

They measured the binary mixtures of 1-propanol with toluene, benzene and cyclohexane at 

303K. The sound velocity, viscosity and density were used to calculate the acoustical parameters 

such as adiabatic compressibility(βa), free length (Lf), free volume (Vf), internal pressure(πi), 

acoustic impedance(Z) and molar volume (Vm).   

  

                          Mr. V. D. Bhandhakar et al (2014) have studied the molecular interaction on 

ultrasonic technique in the binary liquid mixture of Methylmethacrylate in 1, 4-dioxane at 303K 

and 2MHz frequency. The values of density, ultrasonic velocity(U) and viscosity were measured. 

The acoustical parameters such as adiabatic compressibility(βa), intermolecular free length (Lf), 

acoustic impedance (Z ), internal pressure (πi) and relaxation time(τ) were evaluated. The result 

have been discussed with strength of molecular interactions  in the binary system.   

  

                          Mr. Shaik Babu et al (2011) have studied the ultrasonic velocity (U), density, 

viscosity and measurements have been carried out for the binary mixtures of acetyl acetone with 

benzene, carbon tetra chloride and isoamyl alcohol at 301K. From the measured values of 

ultrasonic velocity, density and viscosity, acoustical parameters such as internal pressure (πi), 

free volume (Vf), adiabatic compressibility (βa), molecular free length(Lf), acoustic impedance 

(Z), relaxation time (τ) have been calculated. The results have been analyzed and interpreted in 

terms of molecular interactions.   

  

                          Mr. J. N. Ramteke et al (2014) have studied the ultrasonic velocity,  density, 

viscosity and measured the binary mixtures of triethylamine with Acetonitrile at 305.15K. The 

absorption and velocity of sound in binary mixtures of triethylamine with Acetonitrile have been 

measured at a central frequency of 5MHz, using the interferometer. From the experimental data, 

adiabatic compressibility (βa), free length (Lf), free volume (Vf), internal pressure (πi) acoustic 

impedance (Z) and cohesive energy(H) have been calculated. The adiabatic compressibility and 

excess compressibility were calculated from the velocity and the density measurement. The 

excess parameters have been used to discuss the presence of significant molecular interactions in 

binary mixture.  

  

                            Sk. Md Nayeem et al (2014) have studied the ultrasonic speed (U), density 

have been measured in binary liquid mixtures of cyclohexanone with isomers of butanol at 

308.15K. From the experimental data molar volume (Vm), adiabatic compressibility(βa),  
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intermolecular free length (Lf), acoustic impedance(Z) have been calculated.   

                            Mr. B. Sathyanarayana et al (2006) have studied the densities and speeds of 

sound of mixtures of 1,2 dichloroethane, 1,1,2 trichloroethane, 1,1,2,2 tetrachloroethane, 

trichloroethene and tetrachloroethene with N-methyl acetaminophen at a temperature of 

308.15K. The parameters such as isentropic compressibility and intermolecular free length (Lf) 

have been computed using speed and density values. The results are discussed in the light of 

intermolecular interactions occurring in the solutions.    

  

                            Ms. Archana Pandey et al (2011) have studied the ultrasonic velocity, density, 

refractive indices for systems at 305.15K, 308.15K, 313.15K, 318.15K, 323.15K and 323.15K. 

From the experimental data adiabatic compressibility(βa), intermolecular free length (Lf), 

internal pressure(πi), acoustic impedance (Z), molar refraction, polarizability, thermal expansion 

coefficient, Rao’s molar sound function, solvation number, relative association parameter have 

been computed. The thermal expansion coefficient of the systems from their respective 

experimental densities and refractive indices are estimated by Lorentz-Lorenz equation and 

Eykman equations. The refractive index (n), molar refraction, thermal expansion coefficient and 

polarizability are useful for predicting many physico-chemical properties of solutions.   

  

                            Mr. S. Mullainathan et al (2010) have studied the ultrasonic velocity, density, 

viscosity at 303K in the binary systems of 1,4-dioxane and acetone with water. From the 

experimental data, various acoustical parameters such as adiabatic compressibility (βa), 

intermolecular free length (Lf), free volume (Vf), internal pressure (πi), Rao’s constant (R), 

Wada’s constant (W) and specific acoustical impedance (Z) are calculated. The results are 

interpreted in terms of molecular interaction between the components of the mixtures.   

  

                          Mr. R. Soundar (2021) has studied the ultrasonic velocity, density and viscosity 

for Curcumin with primary alcohols binary mixture viz, 1-propanol at 303K using ultrasonic 

interferometer. Thermodynamic parameters such as adiabatic compressibility(βa), intermolecular 

free length (Lf), free volume (Vf), acoustic impedance (Z) and the molecular association have 

been calculated. The result showed a non linear variations of acoustical parameters which 

confirmed the presence of molecular associative nature.  

 

                           P. Paul Divakar et al (2012) have studied the ultrasonic velocity and 

density measurements in two binary liquid mixtures Isopropyl acetate (IPA) and Isobutyl acetate 

(IBA) with cyclohexanone as a common component at 303K, at fixed frequency of 2MHz using 

single crystal variable path interferometer and specific gravity bottle respectively. The  
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experimental data have been used to calculate the acoustic impedance (Z), adiabatic 

compressibility(βa), intermolecular free length (Lf), and molar volume (Vm). The excess 

thermodynamic parameters have been evaluated and discussed in the light of molecular 

interactions.   

                                      

                            Ms. Susmita Kamila (2012) has studied the ultrasonic velocity and density 

measurements for a number of binary liquid mixtures involving different commercial solvent 

extractants, LIX reagents. The values of velocity have been discussed in terms of percentage 

variations.   

   

                           Ms. S. S. Kulkarni et al (2016) have studied the ultrasonic velocity, density and 

viscosity for the mixture of polyvinylidene fluoride (PVDF) in acetone and dimethylformamide 

(DMF) of various ratios at 300K using ultrasonic interferometer, pykanometer and Ostwald 

viscometer. The acoustic parameters adiabatic compressibility(βa), intermolecular free path 

length (Lf), acoustic impedance (Z), relative association (RA), ultrasonic attenuation, and 

relaxation time(τ) have been estimated using experimental data. The variation of these acoustic 

parameters is explained in terms of solute-solvent molecular interaction in a polymer solution.   

  

                            Mr. G. Nath et al (2009) have studied the densities and ultrasonic velocities of 

binary mixture of diisopropyl ether (DIPE) and bromobenzene (BB) measured at different 

frequencies (1 MHz, 3 MHz and 5MHz) over the range of mole fraction of diisopropyl ether 

(DIPE) at temperature 303K. The intermolecular free length (Lf), isentropic compressibility(βa), 

acoustic impedance (Z) and excess values of isentropic compressibility have been computed 

using values of ultrasonic velocity (C) and density.   

  

                           Mr. Kirandeep Kaur et al (2015) have studied the ultrasonic velocity, density 

and viscosity of binary mixtures of chloroform and methanol using ultrasonic interferometer, 

30ml gravity bottle and Ostwald’s viscometer at frequency 2MHz and constant temperature 

295K. The thermo acoustical parameters like adiabatic compressibility(βa), acoustic impedance, 

intermolecular free length (Lf), relaxation time(τ), ultrasonic attenuation, effective molar weight, 

free volume (Vf), wada’s constant, Rao’s constant, Vander waal’s constant, internal pressure(πi), 

Gibb’s free energy and enthalpy were also computed. The weak interaction between the 

molecules of the binary mixture was founded.  

  

                             B. Nagarjun et al (2015) have done the thermodynamic and acoustic study 

on molecular interactions in certain binary liquid systems involving ethyl benzoate. Speeds of  
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sound and density for binary mixtures of ethyl benzoate N,N-diethyl for a ideal, N,N- Dimethyl 

acetanide and N,N-diethylamide were measured as a function of mole fraction at temperature 

305.15K, 308.15K, 313.15K and 318.15K and atm pressure. From experimental data, adiabatic 

compressibility(βa), intermolecular free length (Lf) and molar volume (Vm) were computed. The 

excess values of the above parameters were also evaluated and discussed in light of molecular 

interactions. Deviation in adiabatic compressibility and excess intermolecular free length are 

found to be negative over the mole fraction of ethyl benzoate indicating the presence of strong 

interactions between the molecules. The result obtained as binary data were correlated as a 

function of mole fraction by using the Redlich-Kister eqn.  

  

                               Mr. A. Moses Ezhil Raj et al (2009) have made the ultrasonic study on binary 

mixture containing dimethyl  formamide and methanol over the entire miscibility range (0<x<1) 

between temperatures 303-323K. The experimental density and speed of ultrasound 

measurements in connection with literature data have been measured for pure N,N-dimethyl 

formamide (DMF), methanol and their binary mixtures over the whole miscibility range at 

different temperatures 303,308,313,318 and 323K. These parameters were used to determine the 

adiabatic compressibility(βa), intermolecular free length (Lf), molar compressibility, molar 

sound velocity, acoustic impedance (Z) and relaxation strength. The complex formation through 

intermolecular hydrogen bonding was confirmed from the recorded FTIR spectra. Available 

thermal energy breaks the bonds between the associated molecules into their respective 

monomers on increasing the temperature The results were found using the measured and 

calculated acoustic parameters.   

  

                                Ms. Srilatha M et al (2015) have made the ultrasonic studies on binary 

mixtures of Ethyl oleate + Isopropanol at 305.15K to 318.15K temperatures. Density, viscosity 

and ultrasonic velocities in the temperature range 303K to 318K were determined for various 

mole fractions of two organic liquids Ethyl Oleate and Isopropanol. Thermo acoustic parameters 

like adiabatic compressibility(βa), intermolecular free length (Lf), excess molar volume (Vm) 

and internal pressure(πi), were calculated. The results were interpreted in terms of intermolecular 

interactions between two organic liquids.  

 

                                Ms.Rupali Talegaonkar et al (2013) have studied some acoustic properties of 

substituted Thiazolyl Schiff’s bases in binary solvent mixtures at 303K. Density and ultrasonic 

velocity(U) in binary mixtures of Thiazolyl substituted Schiff’s bases with dioxane water, 

acetone water and ethanol water mixture were measured at 303K using a ultrasonic 

interferometer at a frequency of 2MHz. Various thermodynamic parameters such as adiabatic 

compressibility(βa), apparent molar compressibility, apparent molar volume, intermolecular free 

length (Lf), specific acoustic impedance (Z) and relative association (RA) have been calculated.  
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The results were used to discuss the interaction between solute and solvent.  

                                       

                                     Mrs.Ninima Mohanty et al (2015) have studied the Thermodynamical  

Acoustic parameters of binary mixture of DBP with Toluene at 308K at different frequencies. 

Ultrasonic investigation of molecular interaction in a binary mixtures of Di-n-butyl phthalate 

with toluene is carried out at different frequencies at temperature of 308K. They measured 

experimental values of density and acoustic parameters such as intermolecular free length (Lf), 

relative association (R), available volume, molar volume (V) etc., The result conveyed that these 

parameters express the nature and strength of molecular interaction of DBP with toluene. 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

 

 

                                                                     7 



                                              CHAPTER III 

MATERIALS AND METHODS: 

             The knowledge of thermodynamic and transport properties of liquid mixtures is useful in 

industrial processes. Ultrasonic and viscometric parameters offer simple, easy and accurate ways 

for calculating several physical parameters which throw light on molecular interactions in 

solutions. Many engineering problems require quantitative data of the viscosity and density of the 

liquid mixtures.               

                    This project deals with the experimental study of ultrasonic velocity, density and 

viscosity in a liquid mixture at room temperature. It deals with a detailed study of ultrasonic 

velocity in liquid mixtures of Ethyl propionate with curcumin for different concentration at 301K. 

The parameters such as ultrasonic velocity (v), density ( ρ) and viscosity(η) and computed 

parameters such as adiabatic compressibility(βa), free length (Lf), acoustical impedance (Z), 

Relaxation time (ι) and ultrasonic attenuations (α/f2) are studied. 

MATERIAL CHOSEN : 

ETHYL PROPIONATE: 

 

 

 

 

                             

USES: 

                   1.  Ethyl propionate is used in perfumery and fragrance. 

2. It is used to manufacture various propionates which is used in the reduction of 

pharmaceuticals, anti-fungal agents, agrochemicals, plastics, plasticizers, rubber 

chemicals, dyes, artificial flavors and perfumery synthesis. 

3. It is also used as a solvent and in nickel-electroplating solutions. 
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CURCUMIN: 

 

 

 

 

 

                                                                                                                      

   USES: 

1. Curcumin is now well established therapeutic agent against cancer, neurodegenerative 

diseases, microbial infections, arthritics and other inflammatory disorders. 

2. It has hepatoprotective, immune-enhancer, cardiovascular and gastrointestinal effects  

 

PHYSICAL PROPERTIES: 

 

      PROPERTIES      ETHYL PROPIONATE               CURCUMIN 

Molecular formula 𝐶5𝐻10𝑂2 𝐶21𝐻20 𝑂6 

Molecular weight            102.133 g/mol             368.38g/mol 

Melting point    -73.6°c(-100.5°F;199.6k)       183°c(361.4°F;456.15k) 

Boiling point     78.9°c(210.0°F;372.0k)     591.4°c(1096.52°F;864.55k) 

Appearance          Colourless liquid             Yellowish liquid 

Density          0.884325 g/𝑐𝑚3               1.3±0.1g/cm³ 

                               Table (3.1) Physical properties of Ethyl Propionate and curcumin. 
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ULTRASONIC INTERFEROMETER 

 

THEORY: 

         Ultrasonic interferometer is a simple and direct device which yields accurate and consistent 

data, from which one can determine the velocity of ultrasonic sound in a liquid medium with a 

high degree of accuracy. A crystal controlled interferometer with operating frequencies ranging 

from 1 to 3 MHz has been used to measure the ultrasonic velocity. 

 

ULTRASONIC DEFINITION: 

           Ultrasonic sound refers to sound pressure with a frequency greater than the human available 

range (20 Hz to 20 KHz). When an ultrasonic wave propagates through a medium, the molecules 

in that medium vibrate over short distance in a direction parallel to the longitudinal wave. During 

this vibration, momentum is transferred among molecule. This causes the wave to pass through 

the medium. 
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ULTRASONIC INTERFEROMETER: 

 

              

                                                 Plate (3.1) Ultrasonic Interferometer. 

                               An Ultrasonic Interferometer is a simple and direct device to determine the 

ultrasonic velocity in liquid with a high degree of accuracy. It is simple in design, rugged and gives 

very accurate and reproducible results. Experiments may be performed over a wide range of 

temperature from -30 °C to +80 °C on all liquids except those which reacts with the plating of cell 

and crystal. Nearly 10 ml of experimental liquid is required. There is no danger of any change such 

as deploymerization, due to ultrasonic effect since a very small ultrasonic energy is required. In an 

ultrasonic Interferometer, the ultrasonic waves are produced by the piezoelectric methods. At a 

fixed frequency variable path Interferometer, the wavelength of the sound in an experimental 

liquid medium is measured, and from this one can calculate its velocity through the medium. The 

ultrasonic cell consists of a double walled brass cell with chromium plated surfaces having a 

capacity of 10ml. The double wall allows water circulation around the experimental liquid to 

maintain it at a known constant temperature. The micrometer scale is marked in units of 0.05 mm 

and has an overall length of 25 mm. Ultrasonic waves of known frequency are produced by a 

quartz crystal which is fixed at the bottom of the cell. There is a movable metallic plate parallel to 

the quartz plate, which reflects the waves. The waves interfere with their reflections, and if the 

separation between the plates is exactly an integer multiple of half wavelength of sound, standing                                                                  
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waves are produced in the liquid medium. Under these circumstances, acoustic resonance occurs. 

The resonant waves are a maximum in amplitude, causing a corresponding maximum in anode 

current of the piezoelectric generator. 

 

WORKING PRINCIPLE: 

                      The principle used in the measurement of velocity is based on the accurate 

determination of the wavelength in the medium. Ultrasonic waves of known frequency (f) are 

produced by quartz crystal fixed at the bottom of the cell. These waves are reflected by a 

movable metallic plate kept parallel to the quartz crystal. If the separation between these two 

plates is exactly a whole multiple of the sound wavelength, standing waves are formed in the 

medium. This acoustic resonance gives rise to an electrical reaction on the generator driving the 

quartz crystal and anode current of the generator become a maximum. If the distance is now 

increased or decreased and the variation is exactly one-half wavelengths or multiple of it, anode 

current become maximum.  From the knowledge of wavelength, the velocity can be obtained by 

the relation; 

 Velocity = Wavelength × Frequency 

            V = λ×f        

 

ADJUSTMENT OF ULTRASONIC INTERFEROMETER: 

            For initial adjustment two knobs are provided on high frequency generator, one is marked 

with “ADJ” to adjust the position of the needle on the ammeter and the knob marked “GAIN” is 

used to increase the sensitivity of the instrument for greater deflection, if desired. The ammeter is 

used to notice the number of maximum deflection while micrometer is moved up or down in liquid. 

PROCEDURE: 

            Unscrew the knurled cap of cell and lift it away from double walled construction of the 

cell. In the middle position of it pour experimental liquid and screw the knurled cap. Wipe out 

excess liquid over flowing from the cell. 

Insert the cell in the heavy base socket and clamp it with the help of a screw provided on its side. 

Connect the high frequency generator with cell by coaxial cable provided with the instrument. In 

ultrasonic Interferometer frequency selector knob should be positioned at desired frequency (same 

frequency as that of liquid cell chosen). Move the micrometer slowly in either clockwise or 

anticlockwise direction till the anode current on the ammeter on the high frequency generator 

shows a maximum or minimum. Note the reading of micrometer corresponding to the maximum 

or minimum (which is sharper) in micro ammeter. Take about 50 reading of consecutive maximum 

or minimum and tabulate them. Take average of all differences (𝜆/2).  Once the wavelength (𝜆) is 

known the velocity (V) in the liquid can be calculated with the help of the relation. 
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MEASUREMENT OF THE DENSITY: 

            The density measurement was made by specific gravity bottle. The specific gravity bottle 

was initially rinsed using acetone (cleaning agent). The weight of the specific bottle was 

measured. Then the weight of the specific gravity bottle with the liquid was measured. From the 

weight measurement the density of the liquid was calculated.  

                                                 Density = M/V (kg/m³)                                                                         

Where, 

          M = mass in kg. 

          V = volume in 𝑚3. 

                      M = Mass of the specific gravity bottle with liquid – Mass of the 

                             empty specific gravity bottle. 

    

Plate:3.2 (a) Specific gravity bottle                                Plate :3.2 (b) Specific gravity bottle  

                                                                                                                with liquid mixture          

 

MEASUREMENT OF VISCOSITY: 

               The viscosity measurements were done through Ostwald's viscometer. The viscometer is 

filled with reference liquid (distilled water). Using a suitable arrangement, the water is sucked 

above the marked level and then it is allowed to flow freely. The water is replaced with a mixture, 

whose viscosity is to be determined. Using the same procedure, the time taken for flow of liquid 

mixture at the experimental temperature was determined. Using the time taken for the distilled  
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water and mixture, the viscosity of unknown liquid mixture is determined: 

                                          η= ρt ×
η0

ρ0t0
     (Nsm−2) 

   Where, 

              𝜌 = density of a liquid in kg/𝑚3 

              t = temperature constant  

              η0 = coefficient of viscosity of water in 𝑁𝑠𝑚−2 

              t0  = time taken by the water in s 

              𝜌0  = density of water in Kg/𝑚3 

 

                                          Plate:3.3 Ostwald’s Viscometer 

                              Viscosity is an important transport property for process design in petroleum, 

petrochemical, chemical and other chemical industries involving fluid transportation, mixing 

agitation, heat exchange and concentration. The estimation of the viscosity of a mixture is more 

difficult than of the pure compound. 
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ADIABATIC COMPRESSIBILITY: 

         The adiabatic compressibility is the fractional decrease of volume per unit increase of 

pressure, when no heat flows in or out. These changes are related to the compressibility of the 

medium by thermodynamic relation. 

                                      βα =
1

V2ρ
     (m2N-1) 

Where, 

               V = ultrasonic velocity of a liquid in m/s. 

                 𝜌 = density of a liquid in Kg/𝑚3. 

 

FREE LENGTH: 

          The free length is the distance covered by sound wave between the surfaces of the 

neighbouring molecules. It is measure of intermolecular attractions between the components in 

binary mixture. The increase of decrease in free length indicates weakling and strengthen of 

intermolecular attraction. As the ultrasonic velocity increase due to the increases in concentration, 

the interaction free length has to decrease and vice-versa. It is related to ultrasonic velocity and 

density as          

                                  Lf =
KT

Vρ
1
2

     (kgms−2) 

    Where, 

                  K = temperature constant  

                  V = velocity of liquid in m/s 

                  𝜌 = density of a liquid Kg/𝑚3 

            The compressibility of a liquid can be expressed in terms of the intermolecular free length 

which is the distance between the surfaces of the neighbouring molecules. 

 

RELAXATION TIME: 

              Relaxation times is the time taken for the excitation energy to appear as translational 

energy and it depends on temperature and on impurities. The dispersion of the ultrasonic velocity 

in binary mixture reveals information about the characteristic time of the relaxation process that 

causes dispersion. The relaxation time (𝜏) can be calculated from the relation; 

                                            τ =
4

3
βaη   (s) 

                                                             15 



Where, 

             βa = adiabatic compressibility of a liquid in 𝑚2𝑁−1 

              η = coefficient of viscosity of a liquid in Ns𝑚−2 

 

 

ACOUSTIC IMPEDANCE: 

                 Sound travels through materials under the influence of sound pressure. Because 

molecules or atoms of a solid are bound elastically to one another, the excess pressure results in 

wave propagation through the solid. 

                        The acoustic impedance (Z) of a materials is defined as the products of its density 

(𝜌) and ultrasonic velocity (v) given as, 

                                           Z = V𝜌   (Kgm-2s-1) 

Where, 

     V = velocity of a liquid in m/s 

     𝜌 = density of a liquid in Kg/𝑚3 

 

ULTRASONIC ATTENUATION: 

                     The amplitude and intensity of ultrasonic waves decrease as they travel through 

tissue, this phenomenon is known as attenuation. For a given fixed propagation distance, 

attenuation affects the high frequency ultrasound waves to a greater degree than lower frequency 

waves. The ultrasonic attenuation (α/f2) can be calculated from the relation, 

                                                  
α

f2
=

8π2η

3ρV2
    (

Np

ms2)    

 

Where,               

  η = coefficient of viscosity of a liquid in N𝑠𝑚−2 

            ρ = density of a liquid in kg/𝑚3 
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                                    CHAPTER – IV 

 

RESULT AND DISCUSSION : 

         

                               Velocity of 3MHz ultrasonic wave in pure liquids, densities and 

viscosities of Ethyl propionate with curcumin were measured with pre calibrated 

interferometer, Density bottle and viscometer respectively to nearest mg in the room 

temperature or tabulated. The values of derived parameters such as velocity (v), density (ρ), 

viscosity (η), adiabatic compressibility (β), free length (Lf), acoustical impedance (Z), 

relaxation time(ι) and ultrasonic attenuation (α/f2) are calculated using standard relations and 

are tabulated. 
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Serial 

no. 

              Percentage%                                                     

          Velocity (v) 

                 (m/s) 
     Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1           1440 

  2       98         2           1380 

  3       97         3           1449 

  4       96         4           1320 

  5       95         5           1380 

  6       94         6           1380 

  7       93         7           1320 

  8       92         8           1380 

  9       91         9           1338 

 10       90        10           1440 

 

Table (4.1): Value of experimental parameter: Velocity (v) 

 

                  

 

  Figure: (4.1) Experimental parameter: Velocity (v)  

 

                      Ultrasonic velocity (v) was found to increase for 1%, 3% and 10% of curcumin. 

It was found to be equal for 2%, 5%, 6% and 8% of curcumin. It was found more or less 

equal and lesser for 4%, 7% and 9% of curcumin. Table (4.1) 
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Table (4.2): Value of experimental parameter: Density (ρ)  

 

 

 

Figure: (4.2): Experimental parameter: Density (ρ) 

                  Density (ρ) was found to be maximum for 1% of curcumin and minimum for 6% 

of curcumin. It was found to have equal values for 2% and 3% of curcumin. Similarly, for 

4%, 7% and 8% of curcumin values of density were found to be equal. For 5%,9% and 10% 

of curcumin values were found to be more or less equal.  Table (4.2) 
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Serial 

no.                  

              Percentage%                                                    Density (ρ) 

         (Kg/m3)      Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1        917.6 

  2       98         2        892.4 

  3       97         3        893.2 

  4       96         4        903.2 

  5       95         5        909.2 

  6       94         6        877.8 

  7       93         7        898.4 

  8       92         8        898.8 

  9       91         9        906.6 

 10       90        10        907.8 



 

 

 

 

       

Serial 

no.                  

              Percentage%                                               Coefficient of Viscosity (η)        

          (10-3) (Nsm-2) 
     Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1           0.5300 

  2       98         2           0.5155 

  3       97         3           0.5253 

  4       96         4           0.5122 

  5       95         5           0.5347 

  6       94         6           0.5070 

  7       93         7           0.5095 

  8       92         8           0.5192 

  9       91         9           0.5237 

 10       90        10           0.5240 

 

Table (4.3): Value of experimental parameter:  Coefficient of Viscosity (η) 

 

  

Figure:(4.3): Experimental parameter: Coefficient of Viscosity(η) 

 

                        Value of viscosity (η) was found to be maximum for 5% of curcumin and 

lowest for 6% of curcumin. It was found to have more or less equal values for 2%, 4% and 

7% of curcumin. Similarly, for 1%,3% and 8% of curcumin values were found to be more or 

less equal for viscosity. For mixtures with 9% and 10% of curcumin, values were found to be 

equal for viscosity. Table (4.3) 
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Serial 

no.                    

               Percentage %                                                           

Adiabatic Compressibility (βα) 

             (10-10) (m2N-1) Ethyl 

Propionate                                                         

   Curcumin 

1       99                        1             5.2555 

2       98          2             5.8841 

3       97          3             5.3322 

4       96          4             6.3543 

5       95          5             5.7754 

6       94          6             5.9819 

7       93          7             6.3822 

8       92          8             5.8422 

9       91          9             6.1612 

10       90         10             5.3123 
 

Table (4.4): Value of derived parameter: Adiabatic Compressibility (βa) 

 

 

Figure: (4.4): Derived parameter: Adiabatic Compressibility (βa) 

  

                  Adiabatic Compressibility (βa) was found to have the highest values for 4%, 7% 

and 9% of curcumin. It was found to be more or less equal in 2%, 5%, 6% and 8% of 

curcumin.  Lowest values were found for 1%, 3% and 10% of curcumin for adiabatic 

compressibility. Table (4.4) 
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Serial 

no. 

              Percentage%                                                      

           Free Length (Lf) 

           (10-10) (Kgms-2) 
     Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1                           0.4548 

  2       98         2          0.4812 

  3       97         3          0.4518 

  4       96         4          0.5001 

  5       95         5          0.4768 

  6       94         6          0.4852 

  7       93         7          0.5014 

  8       92         8          0.4795 

  9       91         9          0.4924 

 10       90        10          0.4573 
 

Table (4.5): Value of derived parameter: Free Length (Lf) 

 

 

 

Figure: (4.5): Derived parameter: Free Length (Lf) 

          

               In Free length (LF) higher values were reported for 4% and 7% of curcumin. It was 

found to have lower values for 1%,3% and 10% of curcumin. It was found to be more or less 

equal for 2%,5%, 6%,7%,8% and 9% of curcumin. Table (4.5) 
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Table (4.6): Value of derived parameter: Acoustic Impedance (Z) 

 

 

Figure: (4.6): Derived parameter: Acoustic Impedance (Z) 

 

                         Acoustic Impedance (Z) was found to increase in 1%, 3% and 10% of 

curcumin. It was found to decrease in values for 4% and 7% of curcumin. It was found to 

have more or less equal values for 5% and 8% of curcumin. Similarly, 2%,6% and 9% of 

curcumin were found to have more or less equal values. Table (4.6) 
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Serial 

no.                  

              Percentage%                                               

      Acoustic Impedance (Z) 

           (106) (Kg m-2 s-1)      Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1             1.3213 

  2       98         2             1.2315 

  3       97         3             1.2942 

  4       96         4             1.1922 

  5       95         5             1.2546 

  6       94         6             1.2113 

  7       93         7             1.1858 

  8       92         8             1.2403 

  9       91         9             1.2130 

 10       90        10             1.3072 



 

 

    

Serial 

no.                     

               Percentage %                                        

    Relaxation Time (ι) 

          (10-12) (s) 
     Ethyl 

Propionate                                               

    Curcumin 

  1       99         1           0.3713 

  2       98         2           0.4044 

  3       97         3           0.3734 

  4       96         4           0.4339 

  5       95         5           0.4117 

  6       94         6           0.4043 

  7       93         7           0.4339 

  8       92         8           0.4044 

  9       91         9           0.4302 

 10       90        10           0.3711 

  

Table (4.7): Value of derived parameter: Relaxation Time (ι) 

 

   

 Figure: (4.7): Derived parameter: Relaxation Time (ι) 

 

                          Relaxation Time (ι) was found to be maximum for 4%, 7% and 9% of 

curcumin. It was found to have minimum values for 1%,3% and 10% of curcumin. It was 

found to have more or less equal values for 2%,5%,6% and 8% of curcumin.  Table (4.7) 
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Serial 

no.                  

             Percentage %                                                 

     Ultrasonic Attenuation (α/f2) 

             (10-13) (Np/ms2)      Ethyl             

Propionate                                                  

   Curcumin 

  1       99         1           0.7323 

  2       98         2           0.7975 

  3       97         3           0.7364 

  4       96         4           0.8557 

  5       95         5           0.8119 

  6       94         6           0.7974 

  7       93         7           0.8557 

  8       92         8           0.7975 

  9       91         9           0.8483 

 10       90        10           0.7318 
 

Table (4.8): Value of derived parameter: Ultrasonic Attenuation (α/f2) 

 

 

Figure: (4.8): Derived parameter: Ultrasonic Attenuation (α/f2) 

                        Ultrasonic Attenuation (α/f2) was found to have the highest values for 4%,7% 

and 9% of curcumin. It was found to have the lowest values for 1%,3% and 10% of 

curcumin. It was found to be more or less equal for 2%, 5%, 6% and 8% of curcumin. Table 

(4.8) 
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                                    CHAPTER -V    

    

CONCLUSION:    

               The ultrasonic velocity (v) density (ρ) and viscosity (η) have been measured  for 

experimental liquid mixture of Ethyl propionate  with curcumin .From these data  few 

acoustical parameters such as Adiabatic compressibility (βα), Free length (Lf),Relaxation time   

(ι), Acoustical impedance ( Z) and Ultrasonic attenuation (α/f2) have been computed using 

standard relations .The variation in ultrasonic velocity  and other parameters  play significant 

role in understanding the solvent – solvent, intra and intermolecular interactions between the 

constitute molecules.    
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Serial 

no. 

              Percentage%                                                     

          Velocity (v) 

             (m/s) 

         

          Density (ρ) 

            (Kg/m3)                        

 

    Coefficient of Viscosity (η) 

             (10-3) (Nsm-2) 
     Ethyl             

Propionate                                                  

   Curcumin 

  1       99   1           1440        917.6           0.5300 

  2       98   2           1380        892.4           0.5155 

  3       97   3           1449        893.2           0.5253 

  4       96   4           1320        903.2           0.5122 

  5       95   5           1380        909.2           0.5347 

  6       94   6           1380        877.8           0.5070 

  7       93   7           1320        898.4           0.5095 

  8       92   8           1380        898.8           0.5192 

  9       91   9           1338        906.6           0.5237 

 10       90  10           1440        907.8           0.5240 
                      

                                                   Table (5.1): Values of experimental parameters: v, ρ, η 

  

 

 

 

 

 

 

 

                                                                                                     



 

 

 

     

Serial 

no.                    

               Percentage %                                                           

          Adiabatic     

 Compressibility (βa) 

      (10-10) (m2N-1)                     

   

                                                         

  

Free Length (Lf) 

(10-10) (Kgms-2) 

 

  

     Acoustic     

Impedance(Z) 

(106) (Kg m-2 s-1)     

                                           

 

Relaxation Time(ι)     

        (10-12) (s)                           

 

 Ultrasonic Attenuation (α/f 2) 

           (10-13) (Np/ms2) Ethyl 

Propionate                                                         

   

Curcumin 

1       99                        1          0.4548             1.3213           0.3713           0.7323             5.2555 

2       98          2          0.4812             1.2315           0.4044           0.7975             5.8841 

3       97          3          0.4518             1.2942           0.3734           0.7364             5.3322 

4       96          4          0.5001             1.1922           0.4339           0.8557             6.3543 

5       95          5          0.4768             1.2546           0.4117           0.8119             5.7754 

6       94          6          0.4852             1.2113           0.4043           0.7974             5.9819 

7       93          7          0.5014             1.1858           0.4339           0.8557             6.3822 

8       92          8          0.4795             1.2403           0.4044           0.7975             5.8422 

9       91          9          0.4924             1.2130           0.4302           0.8483             6.1612 

10       90         10          0.4573             1.3072           0.3711           0.7318             5.3123 
 

                                                        Table 5.2 :-  Values of derived parameters : βa, Lf, Z, ι, α/f2 
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1.1 INTRODUCTION: 

Nanotechnology is booming due to the emergence of nanomaterials (especially 

inorganic nanoparticles (NPs) and nanorods) with unique functions and size-

dependent 2on-me-chemical properties, which are different from each other. 

Significantly different from bulk materials [1]. The potential of inorganic NPs has 

been explored worldwide in nanomedicine, drug delivery and biomedical devices, 

cosmetics, electronics, energy field and environmental protection [2–4]. Among 

inorganic NPs, silver nanoparticles (AgNPs or nanosilver), due to their novel 

chemical, physical and biological properties compared with their bulk form, have 

attracted the attention of researchers from various academic laboratories [5]. AgNPs 

have exceptional physical and chemical properties, for example, high thermal and 

electrical conductivity, surface-enhanced Raman scattering, chemical stability, 

catalytic activity, and nonlinear optical behaviour [6]. These attributes place AgNPs 

at the top of the priority list for use in printing inks, electronics and for medical 

purposes [7]  

Recently, the number of publications on the topic of AgNPs has increased 

rapidly and the number of articles published has increased by 93% since 2001-2011. 

During this period, in 2001 there were 247 articles published, in 2011 it increased 

to 3603 articles. Most of them have been published in the fields of chemistry, 

materials science [8], physics, engineering, polymer science, spectroscopy, 

electrochemistry, molecular biochemistry, optics and spectroscopy [9]. 

1.2 SCOPE OF NANOSCIENCE AND TECHNOLOGY: 

The prefix “nano” refers to a Greek prefix that means “dwarf” or something 

very small and represents one thousandth of a millionth of a meter (10^−9 m). It is 
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important to distinguish between nanoscience and nanotechnology. Nanoscience is 

the study of structures and molecules at the nanometer scale from 1 to 100 nm and 

the technology to use it in practical applications like devices etc, called 

nanotechnology [10]. For comparison, realize that a human hair is 60,000 nm thick 

and the DNA double helix has a radius of 1 nm [11]. Nanotechnology is the ability 

to transform nanoscience theory into useful applications by observing, measuring, 

manipulating, assembling, controlling, and fabricating matter at the nanometer 

scale. 

 

Fig 1.1 Scope of Nanoscience and Technology 

1.3 NANOSCALE: 

Nanoscale usually refers to length-scale structures applicable to 

nanotechnology, usually reported to be 1-100 nanometers. Nanometers are one 

billionth of a meter. Nanoscale is the lower limit of most solid mesoscopic scales. 

It is not possible to clearly and quickly define what the nanoscale is, but there are 

some very important things. It is small in size and has different characteristics 
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Fig 1.2 Shape of Nanoparticle 

1.4 TYPES OF NANOPARTICLES: 

Organic and inorganic nanoparticles are the two basic types of nanoparticles. 

Micelles, dendrimers, liposomes, hybrid and compact polymeric nanoparticles fall 

within the first category. Fullerenes, quantum dots, silica, and metal nanoparticles 

make up the second group. The appearance, size, and chemical properties of 

nanoparticles are also used to classify them. Some of the most important classes of 

nanoparticles are based on physical and chemical characteristics: 

 Carbon-based materials – (fullerenes, carbon nanotubes, graphene, 

carbon dots). Electrical conductivity, high strength, structure, electron affinity, and 

adaptability are all attractive features of these materials. 

 Metal – They are constructed entirely of metal predecessors. These have 

unusual optoelectrical qualities due to well-known localised surface Plasmon 

resonance (LSPR) features. 

 Ceramics – Researchers are paying close attention to these inorganic 

non-metallic solids because of their unique properties. 

 Semiconductor – Semiconductor materials have qualities that are 

intermediate between metals and 4on-metals, as well as large band gaps. Their 
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qualities are significantly altered as a result of band gap tuning. As a result, they’re 

crucial in photo catalysis, photo optics, and electronic devices. 

 Polymers – For a wide range of applications, including surface coating, 

sensor technology, catalysis, and nanomedicine, scientists have devised a number 

of ways for synthesising polymeric nanoparticles. 

 Lipids – These NPs include lipid moieties and are used as medication 

carriers in a variety of biological applications (the mRNA Covid-19 vaccines are 

using lipid nanotechnology). Lipid nanoparticles are also thought to be a viable 

delivery mechanism for nucleic acids in gene therapy. 

1.5 DIMENSIONALITY AND CLASSIFICATION OF NANOPARTICLES: 

Dimensionality, shape, composition, homogeneity, and aggregation are all used 

to classify nanoparticles. 

• Zero-dimensional nanomaterials 

OD are nanosized particles that have their length and width within the 

nanometer range, they are simply nanoparticles. 

• One-dimensional nanomaterials 

The circuitry of computer chips and the antireflection and hard coatings on 

eyeglasses are examples of one-dimensional thin films or surface coatings on the 

nanoscale scale. Electronics, chemistry, and engineering have all employed them. 

• Two-dimensional nanomaterials 

Nanomaterials with two dimensions have two dimensions on the nanoscale 

scale. Nanopore filters for tiny particle separation and filtration are examples of 2D 
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nanostructured films with nanostructures securely linked to a substrate. 2D 

nanoparticles, such as asbestos fibres, are an example. 

• Three-dimensional nanomaterials 

3D nanomaterials are materials that are nanoscaled in all three dimensions. Thin 

films deposited under conditions resulting in atomic-scale porosity, colloids, and 

free nanoparticles of diverse morphologies are among them 

 

Fig 1.3 Dimension of Nanoparticles 

1.6 REVIEW OF LITERATURE: 

L. Balan et al. (2010) proposed extending the concept of photochemically 

assisted synthesis of metal nanoparticles by direct reduction of metal ions or 

complexes to the NIR range, a spectral region of critical interest for in situ 

implementation of integrated optical functions but where photochemical activation 

is often critical due to the weak electronic energy carried by photons. The transient 

species employed to decrease silver cations were used to initiate a 

photopolymerizable formulation. It was discovered that when NIR light is activated 
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at 300 mW/cm2, metal nanoparticles are homogeneously disseminated in the 

appropriate polymer material, resulting in a metal/polymer nanocomposite. The 

structure of the poly-methine sensitizers has specific properties that strongly 

suggest the participation of their triplet state. This achievement could open up new 

avenues in numerous domains of research, where in situ photochemical production 

of MNPs induced by NIR should help overcome technical barriers [12]. 

V. K. Sharma, R. A. Yngard, and Y. Lin et al., (2008) The electrical, optical, 

and catalytic characteristics of silver integrated into polymer and TiO2 surfaces are 

favourable. Different surface modification synthetic techniques were shown, 

resulting in various particle morphologies. To make progress in particle 

interactions, approaches to detect Ag NP transport in vivo on real-time scales are 

required. This will also disclose how Ag NPs affect critical aquatic species and their 

environmental effects. As the usage of Ag NPs in consumer products grows, more 

of these particles will be released into the environment, necessitating a study of the 

environmental concerns connected with these particles. An analytical approach that 

can identify nano-Ag metal from dissolved Ag+ species under environmental 

circumstances is required for ecotoxic investigations on the exposure of Ag NPs. 

Although such approaches are becoming more widely available, their use at low 

doses is still limited [13]. 

D. Kim, S. Jeong, and J. Moon et al., (2006) Thepolyol technique was used to 

create spherical silver nanoparticles of various diameters and standard deviations. 

The influence of reaction parameters on the final particle size and dispersion was 

investigated using two distinct synthesis methods. The ramping rate was shown to 

be a crucial element determining particle size in the precursor heating approach, 

which involved heating a solution containing silver nitrate to the reaction 
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temperature. Because of quick nucleation, the injection rate and reaction 

temperature were critical factors in lowering particle size and achieving 

monodispersity in the precursor injection method, in which a silver nitrate aqueous 

solution was injected into hot ethylene glycol. At a rate of 2.5mls-1 and a reaction 

temperature of   100 °C, silver nanoparticles with a diameter of 172nm were 

produced. [14] 

 J. Yu and X. Zhou et al., (2013), Silver nanoparticles are made via electro 

deposition in an electrolyte with a low Ag+ content and a high overpotential. The 

as-prepared dendritic Ag nanoparticles have good SERS characteristics and can be 

employed as a suitable substrate for Rhodamine 6G detection in practical SERS 

applications [15]. 

1.7 OBJECTIVE OF THE PRESENT WORK: 

The objective of the present work is: 

 To synthesis Ag Nanoparticles  

 To determine the structure and size of the pure Ag nanoparticles using 

X –Ray Diffraction analysis, SEM and EDAX. 

1.8 SIGNIFICANCE OF SILVER MATERIAL: 

1.8.1 SILVER: 

 Silver nanoparticles are appealing due to their unique properties (e.g., 

size and shape-dependent optical, electrical, and magnetic properties) that can be 

used in antimicrobial applications, biosensor materials, composite fibres, cryogenic 

superconducting materials, cosmetics, and electronic components. Silver 

nanoparticles have been synthesised and stabilised using a variety of physical and 
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chemical methods [16, 17]. The most common chemical processes for the 

manufacture of silver nanoparticles are chemical reduction utilising a variety of 

organic and inorganic reducing agents, electrochemical techniques, 

physicochemical reduction, and radiolysis. Nanoparticle synthesis has recently 

become one of the most fascinating scientific fields, with a growing interest in 

producing nanoparticles using environmentally benign ways (green chemistry). 

Mixed-valence polyoxometalates, polysaccharides, Tollens, biological, and 

irradiation processes are examples of green synthesis approaches that have 

advantages over traditional methods that use chemical agents that are detrimental 

to the environment. 

1.8.2 COMMON USAGE: 

Ag-NPs are widely employed in everyday commercial items such plastics, food 

packaging, soaps, pastes, food, and textiles, resulting in a significant increase in 

their market value [18]. Ag-NPs are important because they can be found in a 

variety of forms, including colloidal (enamel, coatings, and paints), liquid 

(shampoo), solid (blending Ag-NPs with a solid material such as polymer 

scaffolds), and even suspended in materials like soap and nonwoven fabrics. Even 

in the textile sector, where Ag-NPs are used in water filtering membranes [18, 19], 

their value cannot be overlooked. 

1.8.3 APPLICATIONS OF Ag-NPs IN NANOFIELD: 

 Nanomaterials can exist naturally, be formed as by-products of 

combustion reactions, or be engineered specifically to fulfil a certain function. 
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 Nanomaterials are used in a wide range of industries, from healthcare 

and cosmetics to environmental preservation and air purification, due to their 

capacity to create materials in a specific way to perform a specified function. 

 Carbon nanotubes can be utilised to morph aeroplane wings in 

aerospace. The nanotubes are combined in a composite form that bends when an 

electric voltage is applied. 

  Baseball bats produced with carbon nanotubes are lighter and perform 

better, according to the sports industry. Antimicrobial nanotechnology, which is 

employed in things such as towels and mats used by athletes, is another example of 

nanoparticles in this business.  

 Silver nanoparticles possess many valuable optical properties that have 

opened the door to new approaches in sensing and imaging applications, providing 

a wide range of detection modes such as colorimetric, dispersion techniques 

radiation, SERS and MEF, at extremely low detection limits. In addition, 

nanoparticles have made it possible to use diffusion imaging techniques and have 

brought valuable improvements to standard imaging techniques. 

 Military applications for nanomaterials have also been developed. One 

example is the injection of movable pigment nanoparticles into the material of 

soldiers’ uniforms to provide a better kind of camouflage. The military has also 

created sensor devices that can identify biological agents using nanomaterials such 

as titanium dioxide. 

 Nano-titanium dioxide is also used in coatings to create self-cleaning 

surfaces like those found on plastic garden chairs. The coating is coated with a 

sealed film of water, and any dirt dissolves in the film, which is then removed by 

the following shower, thus cleaning the seats. 
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 Engineers may design photovoltaics (PV) and solar thermal devices with 

customised solar absorption rates by controlling the size, shape, and substance of 

the nanoparticle. Solar radiation absorption is substantially higher in nanoparticle-

based materials than in thin films of continuous sheets of material. 

  The Sol-Gel technique is a way to make solid material out of 

nanoparticles. While it is considered a relatively recent industrial technology, it is 

widely employed in a variety of industries, including abrasive powder 

manufacturing, coatings manufacturing, and optical fiber manufacturing. 

1.8.4 BIOLOGICAL APPLICATIONS OF Ag-NPs: 

 Antibacterial Activity of AgNPs : 

o AgNPs appear to be an alternative to antibiotics in terms of antibacterial 

activity and the capacity to overcome antibiotic resistance in bacteria. As a result, 

AgNPs must be developed as antibacterial agents. 

o Due to their huge surface-to-volume ratios and crystallographic surface 

structure, AgNPs appear to be viable antibacterial agents among the many 

promising nanomaterials. 

o  The seminal paper reported by Sondi and Salopek-Sondi[20] 

demonstrated the antimicrobial activity of AgNPs against Escherichia coli, in which 

E. coli cells treated with AgNPs showed the accumulation of AgNPs in the cell wall 

and the formation of “pits” in the bacterial cell wall, eventually leading to cell death. 

 Antifungal Activity of AgNPs : 

o Fungal infections are more common in immunocompromised patients, 

and conquering fungi-mediated disorders is a time-consuming process due to the 

restricted number of antifungal medications now accessible [21]. 
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o As a result, there is an unavoidable and pressing need to produce 

biocompatible, non-toxic, and environmentally acceptable antifungal agents 

o At this point, AgNPs serve a significant function as anti-fungal agents 

against a variety of fungal infections. 

o At doses of 1–7 g/mL, Nano-Ag showed strong antifungal activity 

against clinical isolates and ATCC strains of Trichophytonmentagrophytes and 

Candida species. 

 Antiviral Activity of AgNPs: 

o Viral mediated diseases are frequent and becoming more prominent in 

the world; consequently, creating anti-viral medications is crucial. 

o The mechanisms of the antiviral activity of AgNPs are an important 

aspect in antiviral therapy. 

o AgNPs interact with bacteria and viruses differently depending on their 

size and form [22, 23, 24]. 

o The antiviral activity of nano-Ag integrated into polysulfide ultra-

filtration membranes (nAg-PSf) was tested against MS2 bacteriophage, revealing 

that improved membrane hydrophilicity resulted in considerable antiviral activity 

[25]. 

 Anti-Antigenic Activity of AgNPs: 

o Cancer and numerous ischemia and inflammatory disorders are 

associated with pathological angiogenesis [26]. 

o Several research organisations are working on developing innovative 

pro- and anti-angiogenic chemicals to combat angiogenic illnesses. 

o Although several synthetic molecules with anti-angiogenic properties 

have been discovered, the discovery of a series of natural pro- and anti-
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angiogenicfactors suggests that in the near future, this may provide a more 

physiological approach to treating both classes of angiogenesis-dependent diseases 

[27]. 

1.9 IMAGE OF SILVER NANOPARTICLE : 

  

Fig 1.4 Silver Nanoparticle 
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PREPARATION OF PURE SILVER NANOPARTICLE 

2.1 INTRODUCTION: 

There are few methods to synthesis nanoparticles. Slow evaporation, hydro 

thermal, co-precipitation, sol-gel process are some of them.  

2.2 CHEMICAL APPROACH: 

The chemical, physical, optical, and electrical characteristics of nanomaterials 

are influenced by their size, shape, and surface morphology. Chemical reduction is 

one of the most frequent ways for producing silver nanoparticles using both 

inorganic and organic reducing agents. For the reduction of silver ions (Ag+) in 

aqueous or nonaqueous solutions, various reducing agents such as sodium citrate, 

ascorbate, sodium borohydride (NaBH4), elemental hydrogen, polyol process, 

Tollens reagent, N, N-dimethylformamide (DMF), and poly (ethylene glycol)-block 

copolymers, hydrazine, and ammonium formate are used. 

2.3 CO-PRECIPITATION METHOD: 

 The simultaneous precipitation of a normally soluble component with a 

macro-component from the same solution by the formation of mixed crystals, by 

adsorption, occlusion or mechanical entrapment. Coprecipitation is a kind of 

precipitation where soluble compounds in a solution are eliminated during the 

course of precipitation. Precipitation is a process in which a solid is precipitated 

from a solution containing other ions. These ions are incorporated into the solid by 

adsorption on the surface of the growing particles, physical trapping in the porous 

space, or substitution in the crystal lattice. Adsorption is one of the main co-

precipitation mechanisms. It is a process in which a solid, or adsorbent, is added to 
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a solution containing other ions, known as an adsorbent. In this case, the adsorbents 

are bound to the surface of the solid by physical or chemical interactions between 

the adsorbent and the adsorbent. 

Co-precipitation helps to hold the required cations close together in the reaction 

medium and lowers the temperature of decomposition, just as in the case of the sol–

gel process. The starting materials can be simple metal salts that can easily be 

dissolved in water or other appropriate solvents. 

2.3.1 TYPICAL CO-PRECIPITATION SYNTHESIS METHOD: 

Metals generated from aqueous solutions, reduction from non-aqueous 

solutions, electrochemical reduction, and breakdown of metal organic precursors 

are examples of typical co-precipitation synthesis methods. Metal chalconides are 

generated through reactions of molecular precursors. Oxides are created from 

aqueous and non-aqueous solutions. Coprecipitation with microwave sonication. 

2.3.2 ADVANTAGES:  

Through different chemical reactions in the solution, the co precipitation 

technique has the advantage of directly generating homogenous nanomaterials with 

tiny size and size dispersion. 

 Easy and quick to prepare. 

 Particle size and composition may be easily controlled. 

 A variety of ways to alter particle surface state and overall homogeneity 

 It's cold outside. 

  It saves energy. 

   Doesn't need the use of an organic solvent. 
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2.3.3 DISADVANTAGES:  

 Uncharged species are not included. 

 Trace contaminants in the product may also precipitate. 

 It takes time. 

 Issues with batch-to-batch repeatability. 

 When the reactants have highly differing precipitation rates, this 

approach fails [28]. 

2.4 MATERIAL PREPARATION:   

In the present work, pure silver nanoparticles are prepared by reduction 

method. This method is simplest and convenient pathway to synthesize 

nanoparticles. 

2.4.1 SYNTHESIS OF PURE SILVER NANOPARTICLES: 

First the beaker is washed thoroughly with ethanol. 20g of Poly Ethylene Glycol 

is dissolved in 1litre of distilled water. The mixture is poured in to a beaker and kept 

on a magnetic stirrer and stirred thoroughly for 1hour without setting temperature. 

Further stirred for ½ an hour at 60⁰ C and cooled. 10g of (AgNO3) Silver Nitrate is 

added and stirred for 1½ an hour without setting temperature. The NaOH solution 

is added until pH value reaches approximately 10.The pH value is constantly noted 

to maintain the required pH in the solution using the pH meter. Now the color of 

the solution changes to brownish yellow color. The sample is filtered and heated in 

hot air oven at 100⁰ C. The dried sample is placed in muffle furnace at 700⁰ C. The 

precipitate thus obtained is finely powered. Thus the Silver nanoparticles are 

obtained. The following equipments in the lab were used, 
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 Muffle furnace 

 pH meter 

 Hot air oven 

2.4.2 MUFFLE FURNACE:  

The beaker is first carefully cleaned with ethanol. A Muffle furnace is a jacketed 

enclosure used to heat a material to extremely high temperatures while keeping it 

enclosed and completely protected from extraneous pollutants, chemicals, or 

substances. Muffle furnaces are often lined with stainless steel, making them 

resistant to corrosion. Muffle furnaces were created to mitigate the negative effects 

of combustion-based heating. Unwanted byproducts such as ash, soot, and gas 

emissions are examples of such results. Muffle furnaces can achieve and maintain 

temperatures of up to 1800°C (3270°F). 

 

Fig 2.1 Muffle furnace 

2.4.3 pH METER: 

A pH meter is a scientific tool that determines the acidity or alkalinity of water-

based solutions by measuring hydrogen-ion activity. The pH meter is frequently 

referred to as a "potentiometric pH meter" because it detects the difference in 
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electrical potential between a pH electrode and a reference electrode. The acidity or 

pH of the solution is related to the difference in electrical potential.  

 

Fig 2.2 pH meter 

2.4.4 HOT AIR OVEN: 

Hot air ovens are electrical sterilisation equipment that employ dry heat. The 

temperature is usually controlled using a thermostat. Because the inner layer is a 

poor conductor and the outer layer is metallic, their double walled insulation retains 

the heat in and conserves energy. In addition, there is an air-filled area between 

them to help with insulation. An air circulating fan aids in heat distribution 

uniformity. These come with adjustable wire mesh plated trays or aluminium trays, 

as well as an on/off rocker switch, temperature and holding time indicators and 

controls. 

 

Fig 2.3 Hot air oven 
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Fig 2.1 Synthesis of Silver Nanoparticle 
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2.5 FLOW CHART: 
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CHARACTERIZATION OF NANOPARTICLES 

3.1 INTRODUCTION: 

AgNP characterization is crucial for assessing the functional properties of the 

particles formed. Among the analytical techniques used for characterization include 

UV-vis spectroscopy, X-ray diffractometry (XRD), Fourier transform infrared 

spectroscopy (FTIR), and scanning electron microscopy (SEM). Several qualified 

books and reviews have provided the concepts and use of various types of analytical 

techniques for the characterisation of AgNPs; The physicochemical properties of 

nanoparticles regulate their behaviour, safety, and efficacy. As a however, the 

basics of the most essential approaches utilised for the characterization of AgNPs 

are detailed below for ease understanding. 

3.2 UV-VISIBLE SPECTROSCOPY: 

UV-Visible Spectroscopy is based on chemical compounds absorption of 

ultraviolet or visible light, which results in the formation of different spectra. The 

interaction of light and matter is the basis of spectroscopy. Excitation and de-

excitation occur as matter absorbs light, resulting in the formation of a spectrum. 

  

Fig 3.1 UV-Visible spectroscopy 
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When matter absorbs ultraviolet light, the electrons within it become excited. 

This leads them to transition from a ground state (an energy state with a low quantity 

of energy) to an excited state (an energy state with a relatively large amount of 

energy associated with it). It's worth noting that the difference between the energies 

of the electron's ground and excited states is always equal to the quantity of 

ultraviolet or visible energy it absorbs. 

The most significant disadvantage of using a UV-VIS spectrometer is the 

amount of time it takes to prepare for usage. When employing UV-VIS 

spectrometers, proper setup is essential. Outside light, electrical noise, and other 

impurities that could interfere with the spectrometer's reading must be removed. 

3.3 X-RAY DIFFRACTION (XRD): 

X-ray powder diffraction (XRD) is a quick analytical technique that can offer 

information on unit cell dimensions and is mostly used for phase identification of 

crystalline materials. The studied material is finely powdered, homogenised, and 

the bulk composition is calculated on an average basis. 

 

Fig 3.2 X-ray powder diffraction (XRD) 
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In 1912, Max von Laue observed that crystalline substances act as three-

dimensional diffraction gratings for X-ray wavelengths that are similar to plane 

spacing in a crystal lattice. The technique of X-ray diffraction is currently widely 

used to analyse crystal structures and atomic spacing. 

Constructive interference between monochromatic X-rays and a crystalline 

sample is the basis of X-ray diffraction. A cathode ray tube produces the X-rays, 

which are then filtered to produce monochromatic radiation, collimated to 

concentrate the beam, and aimed onto the sample. When Bragg's Law (n=2d sinθ ) 

is satisfied, the incident rays interact with the sample to create constructive 

interference (and a diffracted ray).The wavelength of electromagnetic radiation is 

related to the diffraction angle and lattice spacing in a crystalline sample by this 

rule. After that, the diffracted X-rays are detected, processed, and tallied. Due to the 

random orientation of the powdered material, scanning the sample across a range 

of 2 angles should provide all potential lattice diffraction directions. Because each 

mineral has its own set of d-spacings, converting the diffraction peaks to d-spacings 

enables for mineral identification. This is usually accomplished by comparing d-

spacings to established reference patterns. 

3.4 ENERGY DISPERSIVE X-RAY ANALYSIS (EDAX): 

Energy Dispersive X-Ray Analysis (EDX), referred to as EDS or EDAX, is an 

x-ray technique used to identify the elemental composition of materials. Energy 

dispersive X-ray Analysis (EDX) is an analytical method for analytical or chemical 

characterization of materials. EDX systems are generally attached to an electron 

microscopy instrument such as transmission electron microscopy (TEM) or 

scanning electron microscopy (SEM). EDX is based on the emission of a specimen 
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characteristic X-rays. A beam of high energy charged particles (electrons or 

protons) are focused into the investigated sample. An electron from a higher binding 

energy electron level falls into the core hole and an X-ray with the energy of the 

difference of the electron level binding energies is emitted. EDX analysis gives a 

spectrum that displays the peaks correlated to the elemental composition of the 

investigated sample. In addition, the elemental mapping of a sample can be created 

with this characterization method. 

 

Fig 3.3 Energy Dispersive X-Ray Analysis (EDX) 

3.5 SCANNING ELECTRON MICROSCOPY: 

Scanning electron microscopes (SEMs) have grown in power and versatility as 

the size of materials utilized in diverse applications has shrunk in recent years. 

In the same manner as light microscopes employ visible light for imaging, 

electron microscopes use electrons. Unlike transmission electron microscopes 

(TEMs), which detect electrons passing through a very thin specimen, SEMs make 

images by using electrons reflected or knocked off a sample's near-surface area. 
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Because electrons have a shorter wavelength than light, their resolution is superior 

than that of a light microscope. 

The electron beam scans the material in a raster pattern in scanning electron 

microscopy. The electron source first generates electrons at the top of the column. 

These are released when their thermal energy exceeds the source material's work 

function. The positively charged anode then accelerates and attracts them. The 

whole electron column must be vacuum-sealed. The electron source, like all other 

components of an electron microscope, is sealed inside a specific chamber to 

maintain vacuum and protect it from contamination, vibrations, and noise. Vacuum 

not only protects the electron source from contamination, but it also allows the user 

to obtain a high-resolution image. Other atoms and molecules may be present in the 

column if there is no vacuum. The electron beam deflects as a result of their contact 

with electrons, lowering image quality. High vacuum also improves the efficiency 

of electron collection by the detectors in the column. 

 

Fig 3.4 Scanning electron microscopes (SEMs) 
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RESULT AND DISCUSSION 

4.1 CHARACTERISATION USING XRD: 

 The structural characterization of the pure silver oxide nanoparticle is carried 

out by XRD method. From the above observations it is clearly indicates that the 

silver oxide nanoparticles exhibit FCC structure as confirmed from the JCPDS File 

No.: 03-0921.  

The average grain size can be estimated by applying the Scherrer’s equation:  

                        D =  
𝐊

 𝐜𝐨𝐬 
                                                     (1) 

 Where, 

 D is the gain size or particle size (nm) 

  is the full width at half maximum (FWHM ) of a broad diffraction 

peak 

 λ is the X-ray wavelength (1.5406 Å ) 

 θ is the Bragg’s angle  (degree) 

 K is the Scherrer constant (0.9) 

Figure (4.1) shows that the X ray diffraction pattern of Silver oxide 

nanoparticles. . The X-ray diffraction pattern of Ag2O nanoparticles shows sharp 

reflection corresponding to the face-centered cubic (FCC) structure which is in good 

agreement with the reported data of   M. Shume et al [29]. The powder XRD pattern 

for the silver oxide nanoparticles with the high intensity peaks observed at 2θ = 

38.11̊ along the (1 1 1) hkl plane, 2θ = 44.21̊ along the (2 0 0) hkl plane, 2θ = 64.62 ̊

along the (2 2 0) hkl plane and 2θ = 77.60 along the (3 1 1) hkl plane are shown in 
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figure (4.1). The absence of impurity peaks reveals that Ag2O nanoparticles exhibit 

high crystalline quality. 

 

   

Fig 4.1 X ray diffraction pattern of Silver oxide nanoparticles 

4.1.1 CALCULATION: 

       K=0.9 λ=1.5406×10^-10 m 

From equation (1), 

                         D =  
𝐊

 𝐜𝐨𝐬 
                                                                                      

   

 1.    2θ=38.0329  θ=19.0145   β=0.1968 

                      D =
0.9×1.5406×180×10−10

0.1968×cos (19.01645)×3.14
 

         =   
249.5772×10−10

0.60936585
 

           = 40.95687344×10−9m 

10 15 20 25 30 35 40 45 50 55 60 65 70 75 80

0

20

40

60

80

100

120

140

160

180

In
te

ns
ity

(c
ou

nt
s)

2 Theta(degree)



31 
 

    D =   40.95687344 nm 

 

2. θ=44.2009  θ= 22.10045     =0.1476 

                   D =
0.9×1.5406×180×10^−10

0.1476×cos (22.10045)×3.14
 

                      =   
249.5772×10−10

0.4606982988
 

                      =   54.173675×10−9 m 

                   D =   54.173675 nm                                                                                                 

3. 2θ=64.3936  θ= 32.1968  =0.3936 

                             D =     
0.9×1.5406×180×10−10

0.3936×cos (32.1968)×3.14
 

                       = 
249.5772×10−10

0.8778613475
 

                       =    28.43014×10−9m 

                   D =    28.43014 nm 

4. 2 θ=77.4066   θ=38.7033                 β=0.4920 

                   D =    
0.9×1.5406×180×10−10

0.4920×cos(38.7033)×3.14
 

                      =    
249.5772×10−10

0.8292504
 

                           =    30.0967× 10−9 

                               D =    30.0967nm 
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Table 4.1 Calculation of size of silver nanoparticle from XRD pattern 

The average size of silver nanoparticle is 38.4143 nm 

4.2 CHARACTERISATION USING SEM: 

SEM technique is employed to visualize the surface morphology of silver oxide 

nanoparticles. The SEM images of the AgNPs are shown in Fig. (4.2 - 4.4). The 

images are almost cubed like structure fig. (4.2) rod shaped fig. (4.3, 4.4) while 

some of the others are elliptical in shape. The shape of nanoparticles depends 

on their interaction with stabilizers and the inductors around them and also their 

preparation method. 

 

          Fig 4.2 Scanning Electron Microscope (SEM) image of silver nanoparticles
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Fig. 4.3 Scanning Electron Microscope (SEM) image of silver nanoparticles 

 

 

     Fig. 4.4 Scanning Electron Microscope (SEM) image of silver nanoparticles 
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4.3 CHARACTERIZATION USING EDAX: 

 The purity of Ag nanoparticles was analyzed by EDX pattern as revealed 

in Fig. 4.1. Sharp and distinct peak of silver is observed at 3 keV. Thus, presence of 

sharp and intense peaks of Ag shows the high purity of synthesized nanoparticles. 

Elemental composition analysis by EDX presented strongest signal from silver (Ag) 

region and weaker signals from O, P, S and C atoms. It also showed that pure 

crystalline nature was only composed of silver. 

 

 

Fig 4.5 Energy Dispersive X-ray analysis (EDAX) of silver nanoparticles 
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CONCLUSION 

5.1 CONCLUSION: 

In conclusion, silver nanoparticles with mean diameters of 28, 40, 54 and 30 nm 

were synthesized using Sodium Hydroxide (NaOH) as a reducing agent. The 

nanoparticles were characterized by EDX, XRD and SEM. XRD show the 

characteristic plasmon absorption peak for the silver nanoparticles ranging 38 nm. 

The energy-dispersive spectroscopy (EDX) of the nanoparticles dispersion 

confirmed the presence of elemental silver particle and no peaks of other impurity 

were detected.  

The size, shape, and morphology of nanoparticles are all controlled by particular 

criteria such as reaction kinetics, temperature, pH, and so on, so that the synthesis 

method is selective in producing the nanoparticle that is desired. 

Characterization of AgNP is a crucial step in determining their properties and 

learning about their composition, structure, and morphology. It also allows us to 

determine when the synthesis process is complete and assess its quality. 

Physical and chemical synthesis methods can be used to create silver 

nanoparticles. Every year, hundreds of research articles detailing various Ag-NP 

synthesis strategies are published. We have just studied a few of the most important 

publications through this project, which largely deal with physical and chemical 

methods. All known applications for metallic silver might employ nanosilver 

instead of silver to take advantage of nanosilver's unique features, according to the 

literature. Despite all of nanosilver's advantages, its environmental impact is 

problematic. These synthesis methods may necessitate the use of various raw 
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materials, as well as the usage of hazardous products or wastes to produce 

reactions. However, there are various research in the literature regarding nanosilver 

synthesis methods, but the most widely utilised methods in the industry are yet to 

be known. As a result, we propose that researchers be directed to work on industry-

standard methods for manufacturing nanosilver. In the future, we'd like to carry on 

further research on nanoparticles, giving importance to bio (green) synthesis of 

nanoparticles. 
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ABSTRACT 

 

Copper oxide thin films were fabricated by SILAR method. The structural and optical properties were 

studied. The structural features of the CuO thin films were determined with the help of XRD analysis. 

The XRD spectrum of the thin films prepared at 0.1 M precursor concentration, grown at room 

temperature were obtained. XRD spectrum reveals that the sample has polycrystalline CuO phase 

with a monoclinic crystal structure and with agreed standard data. The peaks were obtained at 2 

=32.47 and 2 =39.64. In the present work, UNIT CELL software is used to calculate the cell 

constant and cell volume. In addition to that the structure of the sample is confirmed. The crystallite 

size was calculated to be D=14.78 nm. The optical properties of CuO thin films were studied using 

UV-vis spectroscopy. In the UV-vis absorption spectra the peak observed at 348 nm indicates the 

presence of CuO. The optical band gap was calculated and its value was found to be 3.5 eV. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

CONTENTS 
 

 
 

 

CHAPTER 

 

CONTENT 

 

PAGE NO 

 

I 

 

INTRODUCTION 

 

1 

1.1 Cornerstone 3 

1.2 Future of Nanotechnology 4 

1.3 Nano thin film 5 

1.4 Applications 5 

1.5 Cuo 5 

1.6 Structure of Cuo 7 

1.7 Properties of Cuo 8 

1.8 Objectives 10 

 

II 

 

LITERATURE REVIEW 

 

11 

 

III 

 

EXPERIMENT 

 

16 

3.1 Synthesis of thin film 17 

3.2 SILAR method 18 

3.3 Preparation of Copper oxide thin film 19 

 

IV 

 

MATERIALS AND METHODS 

 

20 

4.1 Chemicals 21 

4.2 Experimental studies 21 

4.3 Characterization techniques 23 

4.4 X-ray Diffraction (XRD) Technique 23 

4.5 UV spectroscopy 25 



        V RESULT AND DISCUSSION 27 

       5.1 Structural characterization 28 

      5.2   UV - vis spectroscopy            33 

       VI CONCLUSION            34 

      6.1 Summary            35 

     VII BIBLIOGRAPHY            36 



1 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

INTRODUCTION 



2 
 

CHAPTER I 

 

 

INTRODUCTION: 

In modern material science, thin film technology has a wide range of unique 

applications and thin film coating technology has been used in electronic and mechanical 

applications from the beginning of the 20th century. In recent years, metal oxide thin films with 

unique properties have attracted considerable attention. CuO is a p-type semiconductor having an 

energy gap width of approximately 1.2 eV. CuO is a secondary copper mineral, which is the most 

stable form of oxidized copper. 

The specific physical and chemical deposition strategies used to develop CuO thin film on glass 

consist of 

 reactive sputtering

 chemical vapour deposition

 spraying

 thermal oxidation

 electro deposition

 deposition of CuO via SILAR

Among these techniques, the deposition of CuO via SILAR method has been utilized as a 

potentially useful technique for preparation of CuO thin film   because of its low cost and simple 

method. 

CuO has a monoclinic structure and many remarkable properties such as, 

 Superconductivity, 

 Catalytic activity, 

 Optoelectronic properties, 

 High stability and 

 Antibacterial activity. 
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 It has various applications such as: 

 Solar energy cells,

 Optoelectronics - high-temperature superconductors, gas detectors, and giant  magneto    

resistive devices,

 Catalysis,

 Biosensors,

 Photoelectrochemical sensors,

 Supercapacitors,

 Lithium ion batteries,

 Infrared photo detectors,

 Electrochemical sensors and

 Gas sensors.

In this study, we report the preparation of copper oxide thin films by the 

deposition of CuO via SILAR technique. The structural, optical properties of the prepared thin 

films were obtained using X-ray diffraction pattern and UV - vis spectroscopy. Various 

microstructural parameters are evaluated and the  results are discussed. 

 

1.1 CORNERSTONE: 

The manipulation of materials on an atomic or molecular  scale especially to 

build microscopic devices (such as robots) placing atoms as though they were bricks, 

nanotechnology will give us complete control over the structure of matter, allowing us to build 

any substance or structure permitted by the  laws of nature. There are four main types of 

intentionally produced nanomaterials: carbon-based, metal-based, dendrimers, and 

nanocomposites. Carbon-based nanomaterials are intentionally produced. Nanotechnology can 

change dental medicine, healthcare and human life profoundly than several developments of the 

past. However, they even have the potential to evoke important   advantages like improved health, 

higher use of natural resources and reduced environmental pollution.
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1.2 FUTURE OF NANOTECHNOLOGY: 

 
In the next 20 years, nanotechnology will touch the life of nearly every 

person on the planet. The potential benefits are mind boggling and brain enhancing. But like 

many of the great advancements in earth's history, it is not without risk. Nanotechnology has an 

impactful and bright future in various fields of application regards to medicine, defense, 

biotechnology and so on. The compactness of the size is considered to be the great advantage of 

using this technology. In future, the objects designed with this nanotechnology are capable of 

harvesting energy from their environment. Currently, many kinds of research have been in the 

field of nanotechnology so that the materials can be able to develop  energy from light, movement, 

variation in temperature, etc., 

 

 
APPLICATIONS OF NANOTECHNOLOGY: 
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1.3 Nano thin film: 

A thin film is a layer of material ranging from fractions of a nanometer 

(monolayer) to several micrometers in thickness. Thin films are created through a process called 

“deposition.” Deposition is a thin film coating process, which is achieved by modifying the four 

states of matter - solid, liquid, vapour and plasma. Nanostructured films are commonly 

created   using magnetron sputtering from an appropriate target material. Films can be elemental 

in nature, formed by sputtering from a pure metal target such as copper or composed of 

compound materials. 

 

1.4 Applications: 

 Thin film materials have been used in semiconductor devices, wireless communications, 

telecommunications, integrated circuits, rectifiers, transistors, solar cells, light- emitting 

diodes, photoconductors and light  crystal displays, lithography, micro- electro mechanical 

systems (MEMS) and  multifunctional emerging. 

 Nano-clays and nanofilms are in use as barrier materials to prevent spoilage by microbes 

and oxygen absorption. These specific films are used to prevent  and reduce the possibility 

of food drying and spoilage. 

 It is used for protecting the surface of many material, especially optical elements, from 

wear, scratches, fingerprints, and even from corrosion. 

 It is used in spectrally selective solar absorbers, solar control glazing, angular  selective 

filters, optical biosensors and decorative paints. 

 

1.5 CuO: 

Copper (II) oxide or cupric oxide is an inorganic compound with the formula CuO. 

The  black solid,  is one of the two stable oxides of copper, the other  being Cu2O or copper(I) 

oxide (cuprous oxide). As a mineral, it is known as tenorite. It is a product of copper mining and 

the precursor to many other copper-containing products and chemical compounds.

https://en.wikipedia.org/wiki/Inorganic_compound
https://en.wikipedia.org/wiki/Oxide
https://en.wikipedia.org/wiki/Copper
https://en.wikipedia.org/wiki/Copper(I)_oxide
https://en.wikipedia.org/wiki/Copper(I)_oxide
https://en.wikipedia.org/wiki/Mineral
https://en.wikipedia.org/wiki/Tenorite
https://en.wikipedia.org/wiki/Copper_extraction
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Chemical formula CuO 

Molar mass 79.545 g/mol 

Appearance black to brown powder 

Density 6.315 g/cm3 

Melting point 1,326 °C (2,419 °F; 1,599 K) 

Boiling point 2,000 °C (3,630 °F; 2,270 K) 

Solubility in water Insoluble 

Solubility Soluble in ammonium chloride, 

potassium cyanide 

insoluble in alcohol, ammonium 

carbonate 

Band gap 1.2 eV 

Magnetic 

susceptibility (χ) 
+238.9·10−6 cm3/mol 

Refractive 

index (nD) 

2.63 

Thermochemistry 

Std molar 

entropy (S 2980) 

43 J·mol−1·K−1 

Std enthalpy of 

formation (ΔfH⦵298) 

−156 kJ·mol−1 

https://en.wikipedia.org/wiki/Chemical_formula
https://en.wikipedia.org/wiki/Molar_mass
https://en.wikipedia.org/wiki/Density
https://en.wikipedia.org/wiki/Melting_point
https://en.wikipedia.org/wiki/Boiling_point
https://en.wikipedia.org/wiki/Aqueous_solution
https://en.wikipedia.org/wiki/Solubility
https://en.wikipedia.org/wiki/Ammonium_chloride
https://en.wikipedia.org/wiki/Ammonium_chloride
https://en.wikipedia.org/wiki/Potassium_cyanide
https://en.wikipedia.org/wiki/Ethanol
https://en.wikipedia.org/wiki/Ammonium_carbonate
https://en.wikipedia.org/wiki/Ammonium_carbonate
https://en.wikipedia.org/wiki/Band_gap
https://en.wikipedia.org/wiki/Electronvolt
https://en.wikipedia.org/wiki/Magnetic_susceptibility
https://en.wikipedia.org/wiki/Magnetic_susceptibility
https://en.wikipedia.org/wiki/Refractive_index
https://en.wikipedia.org/wiki/Refractive_index
https://en.wikipedia.org/wiki/Standard_molar_entropy
https://en.wikipedia.org/wiki/Standard_molar_entropy
https://en.wikipedia.org/wiki/Standard_enthalpy_change_of_formation
https://en.wikipedia.org/wiki/Standard_enthalpy_change_of_formation
https://en.wikipedia.org/wiki/Standard_enthalpy_change_of_formation
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Powder form of CuO 

 

 

 
1.6 STRUCTURE OF CuO: 
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1.7 PROPERTIES OF CuO: 

 

  Chemical data: 

Structure 

Crystal 

structure 

monoclinic, mS8 

Space group C2/c, 15 

Lattice 

constant 

a = 4.6837, b = 3.4226, c = 5.1288 

α = 90°, β = 99.54°, γ = 90° 

Chemical symbol CuO 

CAS no 1317-38-0 

Group Copper 11 

 

Oxygen 16 

Electronic configuration Copper [Ar]3d¹ 4s¹ 

 

Oxygen [He] 2s2 2p4 

https://en.wikipedia.org/wiki/Crystal_structure
https://en.wikipedia.org/wiki/Crystal_structure
https://en.wikipedia.org/wiki/Monoclinic
https://en.wikipedia.org/wiki/Pearson_symbol
https://en.wikipedia.org/wiki/Space_group
https://en.wikipedia.org/wiki/Lattice_constant
https://en.wikipedia.org/wiki/Lattice_constant
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Chemical Composition: 
 

 

 
 

 

 

 

 

Physical Properties: 
 

Properties Metric Imperial 

Density 6.31 g/cm³ 0.227 lb/in³ 

Molar mass 79.55 g/mol  

 

 

Thermal Properties: 
 

 

Properties Metric Imperial 

Melting point 1201°C 2194°F 

Boiling point 2000°C 3632°F 

 

 

 

 

 

 

 

 

 

 

Element Content (%) 

Copper 79.87 

Oxygen 20.10 
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1.8 OBJECTIVES: 

 To give an overview of the preparation of CuO thin-film. 

 To synthesis pure copper oxide thin-film by SILAR method. 

 To realize the potential applications at nanoscale. 

 To provide a critical discussion of the synthesis of CuO thin-film. 

 To provide evidence for the monoclinic structure of CuO thin-films using XRD     

studies. 

   To calculate the crystallite size by using Scherrer’s equation. 

 To obtain the peak using FTIR spectrum to confirm the presence of CuO. 

 To study the optical properties of copper oxide thin film by UV-vis spectroscopy. 


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LITERATURE REVIEW 
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CHAPTER II 

LITERATURE REVIEW 

 

Tatsumi Ishihara, Masakazu Higuchi have prepared CuO thin films by decomposition of self-

assembled multibilayer films as a molecular template was investigated. Furthermore, the CO2 

sensing property of the resultant CuO thin films on a porous BaTiO3 was investigated as a 

capacitive type sensor. Self- assembled bilayer films of a few 1000 layers thickness can be readily 

obtained by casting an aqueous suspension composed of dimethyl dihexadecyl ammoniun bromide 

(DC1–16), Cu(CH3CO2)2 , hexadecyl ethylene diamine and poly(vinyl alcohol). Divalent copper 

ions (Cu2+) which are associated with two hexadecyl ethylene diamine molecules were arranged in 

the hydrophobic layer of the multibilayer film. Rapid heating to the combustion temperature of 

DC1–16 was desirable for removing organic molecules in the multibilayer template. Thin films of 

CuO can be obtained by calcination at temperatures higher than 573 K. The resultant  CuO thin films 

were porous and consisted of fine particles. The capacitance of CuO  thin films prepared from self-

assembled multibilayer films as a molecular template on the BaTiO3 porous substrate exhibited a 

high sensitivity to CO2, which is twice  that of a conventional mixed oxide capacitor of CuO–

BaTiO3. The capacitance of CuO thin films on BaTiO3 increases with increasing CO2 concentration 

in the range from 100 ppm to 50% at 873 K. Consequently, it is concluded that CuO thin films on 

BaTiO3 were appropriate capacitive type CO2 sensor. 

 

Hassan Zare Asla has prepared CuO thin films on glass substrates at a wide range of 

temperatures from 450ºC to 550ºC with steps of 25ºC by chemical spray pyrolysis technique. 

Aiming to investigate the effect of annealing  process, one of the resulting films was annealed at 

450ºC for 3 hours under ambient  air. Based on X-ray diffraction, all the resulting films are 

monoclinic with two prominent peaks at ~36º and ~39º. The crystallite size of the CuO film 

deposited at 450ºC was found to be the largest in comparison with the others. As the substrate 

temperature increased, a gradual change was observed for the CuO thin film surface  morphology 

and in the case of annealed film, the grains and their boundaries became indistinguishable. The 

resistivity of the films was reduced by virtue of increasing the  substrate temperature and also, both 

the mobility and carrier concentration of the annealed film were improved drastically after 

annealing. As expected, the CuO thin  films absorption was considerable in the visible region and 
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gradually declined after  800nm. The estimated band gap value of the CuO film deposited at 450ºC 

were fairly  close to the optimum band gap for solar applications. 

 

Diwakar Chauhan, Satsangi, have prepared  Nanostructure copper oxide thin films (CuO) were 

prepared on conducting glass support (SnO2: F over layer) via sol–gel starting from colloidal 

solution of copper (II) acetate in ethanol. Films were obtained by dip coating under room 

conditions (temperature, 25–32°C) and were subsequently sintered in air at different temperatures 

(400–650°C). The evolution of oxide coatings under thermal treatment  was studied by glancing 

incidence X-ray diffraction and scanning electron microscopy. Average particle size, resistivity 

and band gap energy were also determined. Photo electrochemical properties of thin films and 

their suitability for splitting of water were investigated. Study suggests that thin films of CuO 

sintered at lower temperatures (≈ 400°C) are better for photo conversion than thick films or the 

films sintered at much higher temperatures. Plausible explanations have been provided. 

 

V. Patil, D. Jundale have prepared nanocrystalline copper oxide (CuO) thin films were deposited 

onto glass substrates by a spin coating technique using an aqueous solution of copper acetate. 

These films were characterized for their structural, morphological, optoelectronic properties by 

means of X-ray diffraction (XRD) scanning electron microscopy (SEM), UV spectroscopy and 

four probe method. The CuO films are oriented along (1 1 1) plane with the monoclinic crystal 

structure. These films were utilized in H2S sensors. The dependence of the H2S response on the 

operating temperature, H2S concentration of CuO film (annealed at 7000C) was investigated. The 

CuO film showed selectivity for H2S. The maximum H2S response of 25.2 % for the CuO film at 

gas  concentration of 100  ppm at operating temperature 2000C was achieved. 

Y.F. Lim, C. S. Chua have prepared CuO thin films by a sol–gel spin-coating process. Sol–gel 

deposition has distinctive advantages such as low-cost solution processing and uniform film 

formation over large areas with a precise stoichiometry and thickness control. Pure-phase Cu2O 

and CuO films were obtained by thermal annealing at 500 °C in nitrogen and ambient air, 

respectively. The films were successfully incorporated as photocathodes in a photo 

electrochemical (PEC) cell, achieving photocurrents of -0.28 mA cm-2 and -0.35 mA cm-2 (for 

Cu2O and CuO, respectively) at 0.05 V a reversible hydrogen electrode (RHE). The Cu2O 

photocurrent was enhanced to −0.47 mA cm-2 upon incorporation of a thin layer of a NiOx co-
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catalyst. Preliminary stability studies indicate that CuO may be more stable than Cu2O as a 

photocathode for PEC  water-splitting. 

Khawla Khashan has prepared CuO thin films spray pyrolysis method using different 

concentration of CuCl2 .2H2O. X- ray diffraction (XRD) and  UV-VIS transmission spectroscopy 

were employed to characterize the structure and  optical properties of prepared films. XRD patterns 

show that the films are polycrystalline and monoclinic with (-111) and (111) crystalline 

orientations. The optical band gaps (2.05 to2.42eV), with high absorption coefficient change from 

(3*105 - 1*105) cm-1 at 0.3M concentration and excitation coefficient change from  (0.85 – 0.7). 

These constants are found to be oscillatory in nature, which are attributed to the particular 

structure of films and their concentration. 

Ashwin Kumar, Saikumar have prepared CuO thin films utilizing RF  sputtering technique with 

deposition occurring at room temperature followed by thermal annealing between 100°C and 

400°C and using different gases, oxygen (O2)  (oxidizing and reactive gas) and nitrogen (N2) (inert 

gas), besides air. Afterwards, these thin films were evaluated for a range of wavelengths: 200 - 

400 nm (UV spectrum), 400 - 700 nm (Visible spectrum), and 700 - 800 nm (IR spectrum), for 

both, optical transmittance and photoluminescence. In addition, the CuO results were compared to 

our Cu2O results from a previous study to assess their differences.  In the results of this study, the 

CuO thin film initially had a bandgap of 2.19 eV at room temperature and by increasing the 

annealing temperature to different levels, the bandgap decreased respectively. The presence of air 

in the chamber allowed for the highest decrease, followed by the nitrogen (N2) and the lowest 

decrease was observed in the presence of oxygen (O2). This was reflected in the decrease in the 

bandgap values from 2.19 eV (room temperature) to 2.05 eV for the films annealed  at 400°C. 

Shinho Cho has prepared Copper oxide thin films deposited on glass substrates at various growth 

temperatures by the reactive radio-frequency magnetron sputtering method. The band gap energy, 

carrier concentration and figure of merit of the CuO thin films were found to depend significantly 

on the growth temperature. All of the CuO films, irrespective of growth temperature, showed a 

monoclinic structure with the main CuO (111)(111) orientation, and the crystallite  size, determined 

by using Scherrer’s formula, was about 50 nm for the thin film deposited at 25 °C. The highest 

figure of merit occurred for the film grown at 300°C with an optical transmittance of 62.9% in the 

wavelength range of 800–1100 nm. The results suggest that the optimum growth temperature for 

growing high-quality CuO thin films is 300 °C. 
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Mohammad has prepared Al-doped CuO thin film by the thermionic vacuum  arc technique. The 

microstructural, morphological and optical properties were  investigated. According to the X-ray 

diffraction patterns, the polycrystalline CuO material was obtained by means of the Al doping 

element. Using the Scherrer formula, the calculated crystallite size values are between 11 and 28 

nm in different   reflection planes. The thickness of the film was 50 nm. In the optical analysis, the 

average transmittance, absorbance and refractive index were 74%, 0.13 and 2.05 respectively. The 

optical band gap was 2.13 eV, which is in good agreement with the photoluminescence result. In 

the doping by Al, the band gap of the CuO shifted               towards the visible region. 

  

Toshiro Maruyama has prepared polycrystalline copper oxide thin films at  a reaction temperature 

above 280°C by an atmospheric pressure chemical vapour deposition method. The source materials 

were copper dipivaloyl-methanate and oxygen. It has been shown from the experiment that two kinds 

of films, i.e., Cu2O and CuO are grown by controlling oxygen partial pressure. A series of 

characterizations on the film quality by scanning electron microscope, X-ray photoelectron 

spectroscopy, X-ray diffraction and Fourier transform infrared spectrometer has been made and the 

performance of solar thermal conversion are also identified on the produced films. Results show that 

the well-crystallized CuO film has lower infrared transmittances due to the scatterings of light 

through the optically anisotropic monoclinic structure. 

 

Y. S. Lee, D. Chua have prepared nanostructured copper oxide thin films (CuO) on conducting glass 

support (SnO2: F over layer) via sol–gel starting from colloidal solution of copper (II) acetate in 

ethanol. Films were obtained by dip coating under room conditions (temperature, 25–32°C) and were 

subsequently sintered in air at different temperatures (400–650°C). The evolution of oxide coatings 

under thermal treatment was studied by glancing incidence X-ray diffraction and scanning electron 

microscopy. Average particle size, resistivity and band gap energy were also determined. Photo 

electrochemical properties of thin films and their suitability for splitting of water were investigated. 

Study suggests that thin films of CuO sintered at lower temperatures (≈ 400°C) are better for photo 

conversion than thick films or the films sintered at much higher temperatures. Plausible explanations 

have been provided. 
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Chapter III 

EXPERIMENT 

3.1 Synthesis of thin-film: 

In order to obtain thin films with good quality, there are two common deposition techniques: 

physical and chemical depositions. 

*Vacuum thermal evaporation 

*Chemical vapour deposition (CVD) 

 Low pressure (LPCVD) 

 Plasma enhanced (PECVD) 

 Atomic layer deposition (ALD) 

 

 

 
Vacuum thermal evaporation 
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Chemical vapour deposition (CVD) 

 

 

3.2 SILAR METHOD: 

A successive ionic layer adsorption and reaction (SILAR) method is one of 

the chemical methods for making uniform and large area thin films, which is based on immersion 

of the substrate into separately placed cations and anions. 
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3.3 Preparation of Copper Oxide thin films: 

The glass substrates were washed with ethanol and then rinsed with distilled 

water.  It was then hung in air to dry. Solution of Copper Sulphate complex was prepared by 

adding 5ml of Ammonia (NH3) (25%) to copper sulphate solution. To deposit CuO thin film, one 

SILAR cycle involves the following four steps : 

 A well cleaned glass substrate was first immersed into cationic precursor, so that the Cu2+ 

ions were adsorbed into the surface of the substrate. 

 Then the substrate was rinsed with distilled water for 30s to remove loosely  bonded 

Cu2+ ions from the substrate. 

 The substrate was immersed into H2O 900C for 10s so that the OH2+ ions were 

adsorbed. 

 Now, the substrate was allowed to dry in air for 60s. 

 Again the substrate was rinsed with distilled water for 30s to remove loosely  bound OH2- 

ions from the substrate. 

The procedure was carried out at room temperature. The above  cycle was carried out for about 30 

times to obtain CuO thin-film. 
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Chapter IV 

MATERIALS AND METHODS 

4.1 Chemicals: 

 CuCl2 copper chloride 

 Aqueous ammonia NH3 

 Double distilled water 

 Acetone 

 1:1 ethanol 

 Copper ammonia complex (Cu(NH3)4)
2+ 

 
4.2 Experimental studies: 

         Synthesis of Cuo thin film: 

            In a typical synthesis, the glass substrates should be cleaned ultrasonically for 

10 mins, first in acetone and then in a 1:1 ethanol water solution. The substance is dried and stored in 

desiccators. To prepare  0.1M CuCl2 solution  add CuCl2 in 100ml of double distilled water and stir 

the mixture to obtain a well dissolved solution. The pH of the solution should be adjusted  to ~10 by 

adding aqueous ammonia (NH3) 25-28%. Thus a copper ammonia complex [Cu(NH3)4]
2+ is 

obtained. Immerse the substrate in [Cu(NH3)4]
2+ solution    for 30 seconds to create a thin liquid film 

containing [ Cu(NH3)4]
2+ on the substrate.  Now immerse the substrate in hot water immediately 

(900C) for 7 seconds to form CuO layer. Dry the substrate in air for 60 seconds. Rinse the 

substrate in a separate beaker for 30 s to remove large and loosely bound CuO particles. Repeat 

the cycle for   40 times and  more. 

 

Ammonia as reducing agent 
 

In ammonia, the nitrogen atom has one lone pair of electrons which it can donate 

and oxidize (loss of electrons) itself. The species which accepts this lone pair of electrons will be 

reduced. It is a strong reducing agent. 
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Reduction of copper oxide: 

 

3 CuO + 2 NH3  → 3 Cu + N2 + 3 H2O. 
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4.3 CHARACTERIZATION TECHNIQUES: 

In the past years, the advancement in science has taken place mainly with the 

discovery of new materials. Characterization is an important step in the development of exotic 

materials. The complete characterization of any material consists of phase analysis, compositional 

characterization, structural and surface characterization, which have strong bearing on the properties 

of materials. In this section, different analytical technique used to characterize our thin films are 

described with relevant principles of their operation and working. 

 

4.4 X- ray Diffraction (XRD) Technique: 

 
X-ray diffraction (XRD) is a powerful technique for determination of crystal structure 

and lattice parameters. Much of our knowledge about crystal structure and the structure of 

molecules as complex as DNA in crystalline form comes from the use of x-rays in x-ray diffraction 

studies. A basic instrument for such study is the Bragg’s spectrometer. 
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Diffraction in general occurs only when the wavelength of  the wave motion is of  the  same order 

of magnitude as the repeat distance between scattering centers. This condition of diffraction is 

nothing but Bragg’s law and is given as, 

2d sin θ = nλ 

 

where 

d = interplanar spacing 

            θ = diffraction angle 

λ = wavelength of x-ray 

n = order of diffraction 

 

For thin films, the powder technique in conjunction with diffractometer is most commonly used. 

In this technique the diffracted radiation is detected by the counter  tube, which moves along the 

angular range of reflections. The intensities are  recorded on a computer system. The ‘d’ values 

are calculated by knowing the values of θ, λ and n. The X-ray diffraction data thus obtained is 

printed in tabular form on paper and is compared with Joint Committee Power Diffraction 

Standards (JCPDS) data to identify the unknown material. The sample used may be powder, 

single crystal or thin film. The crystallite size of the deposits is estimated from the full width at 

half maximum (FWHM) of the most intense diffraction line by Scherrer's formula as follows 

 

𝟎.𝟗 

 𝑪𝑶𝑺


where 

 

 

 

 

 

 

 

 

D is peak (FWHM) in radians, 

 θ is Bragg's angle. 

 

 

 

D = 
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The X- ray diffraction data can also be used to determine the dimension of the unit cell. This 

technique is not useful for identification of individuals of multilayers or percentage crystallite size, λ 

is wavelength of X-ray used, β is full width at half maxima of the of doping material. 

Applications: 

 To measure thickness of thin films and multi-layers. 

 The electron density and accordingly, the position of the atoms in complex structures, 

may be determined from a comprehensive mathematical study of the x-ray diffraction 

pattern. 

 The powder XRD pattern may be thought of as finger print of the single crystal structure, 

and it may be used to conduct qualitative and quantitative analysis. 

 XRD can also be used to determine whether the compound is solvate or not. It is used to 

access the weathering and degradation of natural and synthetic  minerals. 

 Tooth enamel and dentine have been examined by XRD. 

 

 

4.5 UV spectroscopy: 
 

The unique optical properties of metal nanoparticles are a consequence of 

the collective oscillations of conduction electrons, which when excited by electromagnetic 

radiation are called surface plasmon polariton  resonances. Those changes have an influence on 

the refractive index next to the nanoparticle's surface; thus, it is possible to characterize 

nanomaterials using UV–Vis spectroscopy. Besides, nanoparticles have optical properties that 

are very sensitive to nanoparticles size, shape, aggregation (agglomeration) problems, the 

structure of the particles, concentration changes, etc. Hence a method that is versatile, reliable, 

and economical, like UV–Vis spectroscopy, can be used for the characterization of nanoparticles 

even at very low concentrations. 

Absorption spectroscopy uses electromagnetic radiation between 190 and 800 

nm and is divided into the ultraviolet (190–400 nm) and visible (400– 800 nm) regions. Because 

the absorption of ultraviolet or visible radiation by a molecule leads to a transition among 

electronic energy levels of the molecule, it is also often called electronic spectroscopy. The 
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information provided by this spectroscopy when combined with other sources of spectral data 

provides clues to valuable structural information of various molecules. 

                               In UV–Vis spectroscopy, the intensity of light that is passing through the 

sample is measured. UV–Vis spectroscopy is a fast and easy-to-operate technique for 

nanoparticles characterization, especially for colloidal suspensions. There are several advantages 

of UV–Vis techniques, such as simplicity, sensitivity  and selectivity to nanoparticles and short 

time of measurement and what is more, calibration is not required. Therefore, these techniques are 

increasingly used for nanoparticle characterization in many fields of science and industry. 

                              Measurement of optical properties of nanomaterials based thin films by 

means of UV–Vis spectroscopy. UV–Vis spectroscopy, specifically, allows us to understand 

the following optical properties of thin films: 

o Optical transmittance (T) of semiconductor thin films 

o Refractive Index (n) 

o Film thickness (d) 

o Absorptance (k) 

o Absorption coefficient (ε) 

o Band gap (Eg) of thin films 

o Nanoparticles' size and shape dependent optical properties (e.g., Tunable 

Localized Surface Plasmon Resonance Spectra) 
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RESULT AND DISCUSSION 
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STRUCTURAL ANALYSIS: 

 

X-ray diffraction techniques are a very useful characterization tool to study, non-

destructively, the crystallographic structure, chemical composition and physical properties of 

materials. It can also be used to measure various structural properties of these crystalline phases such 

as strain, grain size, phase composition, and defect structure.  

 

The grain size of the sample is calculated using Scherrer’s formula, 

D = K λ/ β cos θ 

Where 

D → Grain size  

λ → Wavelength of α-ray used (1.54060A)  

K → Scherrer’s constant (≈0.9)  

β → Full width at half maximum  

θ → Diffraction angle  

 

Unit cell software:  

Unit Cell is a program. It refines cell parameters from powder diffraction data. Unlike most existing 

cell refinement programs it does not require initial estimates for cell constants; it uses a non-linear 

least squares method, which allows the refinement to be carried out on the actual observed data (e.g. 

two-theta in the case of angle-dispersive monochromatic diffraction, energy in the case of energy-

dispersive diffraction). These diagnostic tools are particularly valuable in assessing the sensitivity of  

the calculated results to the observations of  individual  Bragg  peaks. 

In the present work, UNIT CELL software is used to calculate the cell constant and cell volume. In 

addition to that the structure of the sample is confirmed. 

 

Output from program Unit Cell - Method of TJB Holland & SAT Redfern 1995 
 

Sample title: CuO 

 

Refined in monoclinic system, using wavelength 1.540600 Å, minimizing the sum of squares of 

residuals in 2 theta 

 

Weighted assuming a value of sigma(2theta) = 0.005 deg 
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Cell parameter errors scale in direct proportion to this weighting value 

 

 

  

 

 

 

 

 

 

    

    

 

Residuals:  Standard, average and maximum deviations:- 

std (2T) = 1.9133  and  (2T) =1.4611 ; max dev (2T) =3.3971 

sigma fit = 584.5172 

students t =  3.16 

 

 

 Correlation matrix: 

 
 

 

 

 

 

 

 

 

 

 Cell Parameters of PbS 

 

 

 

 

 

 

 

 

 

 

Parameter Value Sigma 95% conf 

 

a 4.62434 0.00046 0.00144 

b 3.43311 0.00027 0.00085 

c 5.06117 0.00064 0.00202 

beta 84.38928 0.01268 0.04010 

cell vol 79.9657 0.0138 0.0436 

 a b c beta 

a 1.000    

b -0.099 1.000   

c -0.173 -0.005 1.000  

beta 0.301 0.026 0.368 1.000 

Sample Structure Cell Constant (Å) Cell Volume (Å) 

CuO Monoclinic 

a = 4.6243 

b = 3.433 

c = 5.06117 

79.9657 



30 
 

 

 

 

Reciprocal cell parameters: 

 

                            

 

  
 

 

 

 

 

 

Observed and fitted results: {dependent-variable residuals >2sd are bulleted} 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 a* b* c* beta* 

params 0.2172879 0.2912807 0.1985340 95.6107 

sigma 0.0000234 0.0000228 0.0000270 0.0127 

no h k l d(obs) D(calc) res(d) 2T.obs 2T.calc rest(2T) 

1 1 0 0 5.46360 4.60219 0.86141 16.210 19.271 -3.061* 

2 1 1 0 2.75523 2.75180 0.00343 32.470 32.512 -0.042 

3 0 0 2 2.51846 2.51846 0.00000 35.620 35.620 -0.000 

4 1 1 1 2.27183 2.47659 -0.20476 39.640 36.243 3.397 

5 2 0 0 2.22082 2.30109 -0.08027 40.590 39.115 1.475 

6 2 0 2 1.82542 1.78806 0.03736 49.920 51.037 -1.117 

7 0 2 0 1.75124 1.71656 0.03468 52.190 53.327 -1.137 
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Regression diagnostics (for deletion of each observation i): 

 

(a) Potentially deleterious or influential observations affecting the fit: 
 

 

 

 

 

 

 

 

 

 

 

 

 

(b) Observations most strongly affecting the parameter values 

  DfBetas: cell parameter changes (as % of their standard deviations): 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

no h k l hat dfFits Rstudt sigma[i] d(sig)% 

3 0 0 2 1.000 -11208.118 -0.026 715.7629 22.5 

5 2 0 0 0.766 1.935 1.068 571.2065 -2.3 

6 2 0 2 0.911 -4.940 -1.547 482.9500 -17.4 

7 0 2 0 0.810 -1.706 -0.851 613.3229 4.9 

Limit:    1.000 1.512 2.000   

no h k l da db dc dbeta dv 

1 1 0 0 -32144 2656 2135 -14927 -17175 

2 1 1 0 -218 -312 23 -132 -267 

3 0 0 2 -841340 14 794468 -403740722 581128 

4 1 1 1 1006 22278 2440 -17752 10667 

5 2 0 0 90558 -9547 -14894 53148 47946 

6 2 0 2 -122878 22278 -94398 170358 -59080 

7 0 2 0 10571 -118053 477 -2859 -46907 
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The XRD pattern of the sample CuO thin film is shown in figure 1.  The X-ray diffraction 

pattern of CuO displays two intense peaks and 2θ values are given in table 1. The values agree well 

with the standard value of CuO (JCPDS Card No.48 - 1548). The diffraction peaks observed at 2θ 

values of 32.47 o, 39.64o and the d spacing calculated indicates that the structure corresponds to the 

monoclinic structure of CuO. 

     

 

 

 FIGURE 1 

 

Table 1:  Grain size calculation of CuO 

Sample 

Observed 

2 θ 

(deg) 

FWHM 

(Radians) 

Grain Size 

(nm) 

Average grain size 

(nm) 
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CuO 
32.47 

39.64 

0.5904 

0.5904 

14.63 

14.93 
14 .78 
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UV-VIS SPECTROSCOPY: 

                         

Figure (3) shows the UV-vis absorption spectra of the CuO thin film synthesized at 1000C. The peak 

at 348 nm is due to the presence of CuO.  

 

FIGURE (3) 

 

The optical band gap Eg in eV can be calculated using absorption edge values (λ edge in nm) from 

absorption spectra by using  

1240/λ 

The calculated band gap value is 3.5 eV. The obtained higher value of band gap of CuO film can be 

ascribed to quantum confinement effect. The higher values are due to stoichiometry, crystallinity and 

density and oxygen valencies.
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CHAPTER VI 

 

CONCLUSION 

 

6.1 Summary: 
 

In this investigation, copper oxide thin-films were prepared by SILAR method. 

The structural and optical properties were studied. The structural features of the CuO thin 

films were determined with the help of XRD analysis. The XRD spectrum of the thin films 

prepared at 0.1 M precursor concentration, grown at room temperature were obtained.  

 

The X-ray diffraction pattern of CuO displayed two intense peaks and 2θ values which 

were in agreement with the standard value of CuO (JCPDS Card No.48 - 1548). The diffraction peaks 

observed at 2θ values of 32.47o, 39.64o and the d-spacing calculated indicates that the structure 

corresponds to the monoclinic structure of CuO. The UNIT CELL software is used to calculate the 

cell constant and cell volume. In addition to that, the structure of the sample is confirmed. The 

crystallite size was calculated to be D=14.78 nm.  

 

The optical properties of CuO thin film were studied using UV-vis spectroscopy. In the 

UV-vis absorption spectra the peak observed at 348 nm indicates the presence of CuO. The optical 

band gap was calculated and its value was found to be 3.5 eV. 

 

This study is an evident proof  that  copper oxide thin films can be prepared in a simple 

and cost effective manner using SILAR method to satisfy the needs of various applications in the 

future. 
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CHAPTER-1

INTRODUCTION TO CRYSTALS

“In a crystal we have a clear evidence of the existence of a formative life principle,and though we
cannot understand the life of a crystal,it is nonetheless a living being.”

-Nickola Tesla
1.1 INTRODUCTION:

‘Growing good single crystals is an art.’ The word crystal is derived from the
ancient Greek word krustallos, meaning both “ice”and “rock crystal”. Crystals
are millions of years old, forged during the earliest parts of earth’s formation.Crystal
growth is a vital and fundamental part of material science and engineering, because
crystals of suitable size and perfection are required for fundamental data acquisition
and for practical devices such as detectors, integrated circuits and for other millions
and millions of applications.Crystal growth is a great science project. It is almost an
art rather than a pure science. Behind every new solid state device there stands a
single crystal.[1]

Single crystal is a material in which the crystal lattice of the entire sample is
continuous and unbroken to the edges of the sample, with no grain boundaries. A
good quality of single crystal prerequiite for crystal structure determination by X-ray
diffraction technique.Single crystal may be produced by the transport of crystal
constituents in the solid, liquid or vapor phase.Water is a popular solvent for the
growth of a variety of inorganic and organic compounds. A solvent can also play an
indirect role in changing the morphology of the crystal. [17] This chapter discusses in
detail various experimental techniques with its concept, mechanism and applications
of a single crystal.

1.2 ABSTRACT:
To grow a crystal, the basic condition to be attained is the state of super

saturation, followed by the process of nucleation. The information of super saturation
and nucleation forms the basis of crystal growth.The growth of crystals from liquid
and gaseous solutions, pure liquids and pure gases can only occur if some degree of
super saturation or super cooling has been first achieved in the system. The attainment
of the supersaturated state is essential for any crystallization operation and the degree
of super saturation or deviation from the equilibrium saturated condition is the prime
factor controlling the deposition process.

1.3 SOLIDS:

[1]



A solid is a state of matter with fixed shape and volume. Particles are
closely-packed so they can vibrate, but not flow. Solids are rigid. They cannot be
compressed easily. They are classified as

 Crystalline solids

Single crystal:

It consists of only one crystal. Atoms are in a repeating or over the entire extent
of the material.

Polycrystalline crystal:

Comprised of crystals or grains. Each crystal has periodic arrangement.

 Amorphous solids

In amorphous solids, atoms are arranged in an irregular fashion.
Eg: rubber,plastics and glass.

1.3.1 Crystalline solids:

A crystal or crystalline solid is a solid material whose constituents (such as
atoms, molecules or ions) or arranged in a highly ordered microscopic structure,
forming a crystal lattice that extends in all directions. [8] The smallest repeating
structure of the solid is called a unit cell. Unit cell combine to form a network called
crystal lattice.

[2]



1.3.1.1 Types of crystalline solids:

 Covalent : Are composed of atoms which are covalently bonded to one another.

 Ionic: Composed of alternating positive and negative ions.

 Metallic: Consists of metal cations surrounded by a “sea”of mobile valence
electrons.

 Molecular: They are held together by weak intermolecular forces.

There are fourteen types of lattices called Bravais lattices and they are classified
into seven crystals systems based on the arrangements.

1.3.2 AMORPHOUS SOLIDS:

Any non crystalline solid in which the atoms and molecules are not organised in a
definite lattice pattern. Such solids include glass, plastics and gel. [10] Amorphous
solids are isotropic. The thermal and electrical conductivities, coefficient of thermal
expansion and refractive index of an amorphous solid have the same value in
whatever direction the properties are measured.

[3]



Amorphous solids, lacking the three-dimensional long-range order of a
crystalline material, possess a more random arrangement of molecules, exhibit short-
range order over a few molecular dimensions, and have physical properties quite
different from those of their corresponding crystalline states.

1.4 APPLICATIONS OF CRYSTALS:

Solar Cells

One of the largest uses for crystals is in solar cells. Solar cells power various
instruments from calculators to space vehicles. The solar cell produces energy, called
photovoltaic energy, by using silicon.

Transistors

Made out of semi-conductors, which are based on the same types of materials and
crystals as solar cells, transistors can regulate electron flow, detecting and amplifying
radio signals and hence acting like digital “switches.” Transistor radios, for example,
make this use out of crystals.

Liquid Crystals

This precise substance made out of crystals can be used for a variety of different
means, from heat and electricity to magnetism and mechanics. For example,
wristwatches and some types of clocks use liquid crystals, as do some pocket
calculators.

Spiritual Crystals

[4]



Amethyst crystals are thought to reduce feelings of anger and impatience. Other
crystals uses include: aquamarine to release fear; carnelian to produce confidence;
coral to intensify emotions: diamonds to increase prosperity;and sapphire to restore
calm and a sense of balance.

Medicinal Crystals

Some new age medical practitioners claim that the presence and other uses of
certain crystals promote different kinds of medical benefits. These benefits include:
amethyst to treat headaches or unbalanced blood sugar; aquamarine to regulate the
immune system, heart and lymph nodes; coral to help the metabolism, spine and
tissue regeneration. [4]

1.5 NONLINEAR OPTICS AND NONLINEAR OPTICAL MATERIALS:

Nonlinear optics is given increasing attention due to its wide application in the
area of laser technology, optical communication and data storage technology [6].
Nonlinear optics is completely, a new effect in which light of one wavelength is
transformed to light of another wavelength.In an ordinary optical material, the
electrons oscillate about their equilibrium position at the frequency of this electronic
field. According to the fundamental law of physics, an oscillation change will radiate
at its frequency of oscillation and hence these electrons in the crystal "generate"
light at the frequency of the original light wave.

An NLO material is a compound in which a nonlinear polarization is
invoked on application of an intense electric field. This electric field results from the
external application of an intense laser-source. The nonlinear material is different
from the linear material in several aspects. A nonlinear material is one, whose
electrons are bound by very short springs.

At high fields, the polarization is proportional to the field and hence the
susceptibility starts depending on the field. It is called Non-linear Optics (NLO)
because, at high intensity, the graph representing the dependence of optical
polarization on the light field amplitude has curvature and deviates from straight line.

One of the obvious requirements for a non-linear crystal is that it should have
excellent optical quality. This means that for new materials, for which single crystal
specimens are not available, it is necessary to grow single crystal specimens of optical
quality. Thus in many cases the search for new and better non-linear optical materials
is very largely a crystal growing effort.

[5]



NLO provides major benefits to some very important applications such as:

 Commercial

 Lasers

 Telecommunications

 Sensors

 Environmental monitoring

 Medicine

 Manufacturing and materials processing

 Military, and in scientific instrumentation. [9]

1.5.1 CLASSIFICATION OF NON LINEAR OPTIC MATERIALS:

They are broadly divided into two types, organic NLO materials and inorganic
NLO materials. [16]

[6]



1.5.1.1 ORGANIC NLO MATERIALS:

The first type, molecular materials, consists of chemically bonded moleculer
units that interact in the bulk through weak Van der Waals interactions.For these
materials the optical non-linearity is primarily derived from the molecular
structure.The expression for the nonlinearity is highly dependent on the geometrical
arrangement of the molecules in the case of second order nonlinear processes, but
much less so for third order nonlinearities.The primary step in optimizing optical
nonlinearities in this class of materials is at the molecular structural level, which then
requires a detailed understanding of the relationship between molecular electronic
structure and the nonlinear polarization that can be induced in a molecule.Organic
materials have emerged during 1980’s as an important class of nonlinear optical
materials that offers unique opportunities for fundamentaly research as well as for
technological applications.

Example: Urea,2-methyl-4-nitroaniline.

MERITS:
1. Optically more nonlinear
2. High optical damage threshold
3. Low cost
4. Broad spectral range

DEMERITS:
1. Poor mechanical strength
2. Poor thermal strength
3. Highly volatile

Difficulties in the Crystal Growth of Organic materials:

The principal limitation to the growth of large size, optically
perfect crystals of organic nonlinear optical materials is that the solvent tends to be
adsorbed on the highly polar growing surfaces.This blocks the growth and causes
morphological instability which in turn leads to the formation of solvent inclusions in
the growing crystal.Thermal instability is common with many organic materials.It is
very difficult to obtain large size, well faced transparent organic single crystals.For
fabrication of a SHG element, single crystal of at least minimum dimensions of 3 mm
x 3 mm x 3mm is required.Fragile nature of organic crystal imposes difficulty in
obtaining good quality crystals with less mechanical damage. The practical use of
organic crystals in NLO devices as bulk crystals is limited due to their hygroscopic
nature and difficulties in cutting and polishing.One of the best ways in preserving the
hygroscopic crystals is to keep them immersed in index matching fluids.

1.5.1.2 INORGANIC NLO MATERIALS:

Nonlinearities in these materials are thought of arising from electron not
associated with individual nuclei, such as in those metals and semiconductors.The
optical non linearity in this class is determined by the electronic characteristics of the

[7]



bulk medium and thus requires different theoretical frame works to account for this
origins of nonlinear optical effects.

Examples of materials in these categories are: Quantum, well structures
derived from GaAs, II-VI Semiconductors, and CdSe.

For inorganic systems important higher order nonlinear optical effects (eg: third
order) are resonant (absorptive).Thus, heat dissipation tends to limit the cycle time of
devices derived from these materials. Inorganic NLO materials are used in
commercial applications but they also have drawbacks.

MERITS:
1) High electro optic co-efficient
2) High degree of chemical inertness

DEMERITS:
1) Poor optical quality
2) Difficulty to synthesis.Towards this direction, newer materials are

currently being explored and this has led to a new class of NLO materials viz.,
Semiorganic.

1.6 SALTS:
1.6.1 MAGNESIUM SULPHATE:

Magnesium sulphate is a salt of magnesium with sulphuric acid. It is an
anhydrous inorganic salt. The most common hydrate salt of Mg.SO4 is the
Magnesium sulphate heptahydrate which has 7 molecules of water and has a formula
𝐌𝐠𝐒𝐎𝟒. 𝟕𝐇𝟐𝐎 . This salt is also known as Epsom salt. Magnesium sulphate is an

excellent non linear optical (NLO) medium. Here magnesium sulphate is added with
Copper sulphate to form a single crystal. [14]

Properties of Magnesium Sulphate:
Magnesium sulphate is an anhydrous solid salt of white colour.

 It is an odourless salt.

 Magnesium sulphate salt is soluble in water.

Magnesium sulphate is not soluble in organic solvents like alcohol.

The molecular weight of magnesium sulphate is 120.366 g/mol.

[8]



1.6.2 UREA:

Urea,also called carbamide, the diamide of carbonic acid.Its formula is
𝑯𝟐𝑵𝑪𝑶𝑵𝑯𝟐.It is a colourless,crystalline substance that melts at 132.7ºC (271ºF) and
decomposes before boiling.Urea crystals fall under the category of organic materials
exhibiting superior optical non-linear absorption coefficient.Urea is an non-linear
optical medium. In recent years,various attempts have been made to synthesize
organic and semi-organic urea & urea derivative single crystals.Here urea is added
with Copper Sulphate to form a single crystal.

PROPERTIES OF UREA:

 It is colourless,crystalline solid. [13]

 It is highly soluble in water but less solution in alcohol.

 It is soluble in ether.

 Urea behaves as a mono acid base. It reacts with acids to form salts.

 It reacts with nitrous acid to form nitrogen, carbon dioxide & water.

1.7 COPPER SULPHATE:

Cupric sulfate is a salt created by treating cupricoxide with sulfuric acid.This
forms as large, bright blue crystals containing five molecules of water (CuSO4.7H2O)
and is also known as blue vitriol. The anhydrous salt is created by heating
the hydrate to 150 °C (300 °F). Copper is an essential trace element and an important
catalyst for heme synthesis and iron absorption. It is used as a colouring agent. It is
used as a raw material in the preparation of other copper compounds,as a reagent
in analytic chemistry, as an electrolyte for batteries.

[9]



1.8 ROLE OF IMPURITIES IN CRYSTAL GROWTH:

Impurities are present in all crystallization processes usually impurities are
adventitious and undesirable but sometimes they are intentionally added and are
called additives.Impurities change growth rates,shape and thickness of growth layers
and growth habit,and are trapped as impurity striations and large clusters of impurities
and inhomogeneities.Some of these effects are reviewed for growth of bulk single
crystals [5].The effect of impurities on the growth rate and habit of crystals growing
in solution has been the subject of many experimental and theoretical studies over
many years.Most of the impurities suppress growth,some impurities enhance it,while
some others can stop growth completely even at the very low level of impurity
concentration. The impurity effect depends on impurity concentration,supersaturation
and temperature. Different impurities have different effects on the crystal growth,such
as:

 Some may exert a highly selective effect,acting only on certain crystallographic
faces.

 Some are adsorbed onto growing crystal surfaces.

 Some impurities may modify the habit of the crystalline phase.

1.9 MAIN OBJECTIVES OF THE PROJECT WORK:

In this project work, growth of Copper Sulphate doped Urea and Magnesium
sulphate single crystals were carried out by employing slow evaporation solution
method and various properties of the grown crystals were studied. It is aimed at

 Growing Copper Sulphate added Urea and Magnesium sulphate crystals by Slow
Evaporation Solution Technique (SEST) at room temperature.

 Identifying the size of the particle by powder X-ray diffraction analysis (PXRD).

 Studying the incorporation of the dopant in Urea and Magnesium sulphate
crystals by UV-visible spectral analysis.

 Finding the functional groups present in the grown crystals by Fourier
Transform Infrared (FTIR) analysis.

[10]
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CHAPTER-2

CRYSTAL GROWTHMETHODS

2.1 BASICS OF CRYSTAL GROWTH:

To grow a crystal, the basic condition to be attained is the state of super
saturation, followed by the process of nucleation. The information of super saturation
and nucleation forms the basis of crystal growth.The growth of crystals from liquid
and gaseous solutions, pure liquids and pure gases can only occur if some degree of
super saturation or super cooling has been first achieved in the system. The attainment
of the supersaturated state is essential for any crystallization operation and the degree
of super saturation or deviation from the equilibrium saturated condition is the prime
factor controlling the deposition process.

In general, the crystallization process takes place by three steps:

 Achievement of super saturation or super cooling.

 Formation of crystal nuclei.

 Growth of crystal. [7]

2.2 NUCLEATION:

Nucleation is an important phenomenon in crystal growth and is the pre-cursor
of crystal growth and of the overall crystallization process. The condition of super
saturation alone is not sufficient cause for a system to begin crystallization. Before
crystals can grow, there must exist in the solution a number of minute solid bodies
known as centers of crystallization, seeds, embryos or (nuclei). The formation of
stable nuclei occurs only by the addition of a number of molecules (A1) until a critical
cluster is formed. In general,

A(n-1) + A1 = An (critical)

Once these nuclei grow beyond a certain critical size, they become stable under
the average condition of super saturation of the solution.

[12]



Nucleation may occur spontaneously or it may be induced artificially and they
are usually referred to as homogeneous and heterogeneous nucleation respectively.
The term primary is used for both homogeneous and heterogeneous nucleation even in
systems that do not contain crystalline matter. On the other hand, during secondary
nucleation, nuclei are often generated in the vicinity of the crystals present in the
supersaturated system. This process involves the dislodgement of the nuclei from the
parent crystal at super saturation in which primary homogeneous nucleation cannot
occur. When a supersaturated solution is disturbed by agitation, friction or mechanical
stimulus in the presence of the crystalline substance of the solute, embryos are formed
at the surfaces of the parent crystal. These embryos give rise to secondary nucleation.

If the nuclei form homogeneously in the interior of the phase, it is called
homogeneous nucleation. If the nuclei form heterogeneously around ions, impurity
molecules or on dust particles, on surfaces or at structural singularities such as
imperfections or dislocations, it is known as heterogeneous nucleation. [2]

2.3 METHODS OF CRYSTAL GROWTH:

Crystal growth is a challenging task and the technique followed for crystal
growth depends upon the characteristics of the materials under investigation such as
its melting point, volatile nature, solubility in water or other organic solvents and so
on. [3]The basic growth methods available for crystal growth are

 Growth from melt
 Growth from vapour
 Growth from solution
 Growth from solid

[13]



2.3.1 GROWTH FROM THE MELT:

Melt growth is the process of crystallization of fusion and resolidification of the
pure material, crystallization from a melt on cooling the liquid below its freezing
point. In this technique apart from possible contamination from crucible materials and
surrounding atmosphere, no impurities are introduced in the growth process and the
rate or growth is normally much higher than possible by other methods. Melt growth
is commercially the most important method of crystal growth. The growth from melt
can further be sub-grouped into various techniques.

 Bridgmann method
 Czochralski method
 Vernuil method
 Zone melting method
 Kyropoulos technique
 Skull melting

BRIDGEMANNMETHOD:

This technique was named after its inventor Bridgemann in 1925, Stockbarger
in1938.The Bridgmann technique is a method of growing single crystal ingots or
boules. The method involves heating polycrystalline material in a container above its
melting point and slowly cooling it from one end where a seed crystal is located.
Single crystal material is progressively formed along the length of the container,the
process can be carried out in a horizontal or vertical geometry.

ADVANTAGE:

 This method is technically simple.

 This technique is low cost.

 Selecting the appropriate container can produce crystal of pre assigned
diameter.

[14]



DISADVANTAGE:

 The compression of the solid by the contracting container during cooling can
lead to the development of stresses high enough to nucleate dislocations in the
material.

CZOCHRALSKI METHOD (OR) PULLING TECHNIQUE:

This method is widely used for growing semi conducting material crystal. The
shape of the crystal is free from the constraint due to the shape of the crucible. In this
method the charge is melted and maintained at a temperature slightly above the
melting point. The pulling rod is lowered to just touch the melt. Since the rod is at
lower temperature of melt occurs at the point tip of the pulling rod. The crystal is
pulled slowly. The rate of pulling upon various factors like thermal conductivity,
latent heat of fusion of charge and rate of cooling of the pulling rod. The seed is
rotated to keep the grow crystal uniform and cylindrical.

ADVANTAGE:

 This method is used to grow large single crystals. Thus it is used
extensively in the semiconductor industry.

 There is no direct contact between the crucible walls and the crystal
which helps to produce unstressed single crystal.

DISADVANTAGE:


In general this method is not suitable for incongruently melting compounds and
of course the need for a seed crystal of the same composition limits is used as tool for
exploratory synthetic research.

VERNUIL METHOD:

Chemically pure fine powder which emerges through an Oxygen-hydrogen
flame and falls onto the fused end of an oriented single crystal seed fixed to a
lowering mechanism.

[15]



The powder charge is fed from bankeei by mean of a special tapping
mechanism. Coordinating the consumption of the charge, hydrogen and oxygen with
the rate of descent of the seed ensures crystallization at a prescribed level of the
apparatus.

ADVANTAGE:

 There is no container which eliminates the problem of physical-chemical
interaction between the melt and the container material.

 It is technically simple and the growth of crystal can be observed.

ZONE MELTINGMETHOD:

In this technique a liquid zone is created by melting a small amount of materials
in a relatively large or long solid charge. Zone melting techniques basically enable
one to manipulate distribution of soluble impurities or phases through a solid.

ADVANTAGE:


 Zone melting technique is that impurities tend to be concentrated in the
melted portion of the sample.

 The process sweeps them out of the sample and concentrates them at the
end of the crystal bowl, which is then cut off and discarded.Thus this
method is sometimes used to purify semiconductor crystals.

[16]



KYROPOULOS TECHNIQUE:

In this technique, a cooled seed to initiate single crystal growth within the melt
containing crucible. Heat removal continues by controlling the furnace temperature to
grow the crystal.

ADVANTAGE:

 The crystal is grown in a larger diameter.

 With the large diameter crystal we can make prisms, lenses and other
optical components.

SKULL MELTING PROCESS:

Skull melting process is used for the growth of high melting point materials.
Cubic zirconium is made using a radio-frequency “Skull crucible” system, a
specialized melt process. This is a type of super-hot melt process used to produce the
most widely accepted diamond imitation: Cubic zirconia(cz). Conventional (low) melt
crucibles cannot be used. Therefore a crucible free technique is inevitable. The Skull
melting process is used to produce Zirconia up to 10 cm long.

ADVANTAGES:

 The process is crucibleless, a thin skull separates the molten mass from
the water-cooled container. Thus, contamination problems or exsolution
processes associated with contact between melts and hot crucibles are
avoided.

[17]



 Single crystals of considerable size and perfection may readily be grown
in copious quantities. [18]

2.3.2 GROWTH FROM VAPOUR:

VAPOUR GROWTH:

Crystallization from Vapour is widely adopted to grow bulk crystal, epitaxial
films, and thin coatings. Techniques for growing crystals from vapour is divided into
two types they are,

 Chemical transport method
 Physical transport method

CHEMICAL TRANSPORT METHOD:

This method involves a chemical transport in which material is transported as a
chemical compound (halide),which decomposes in the growth area. In this case
depending on the nature of the reaction involved. The growth region may be either
hotter or cooler than the source.

PHYSICAL TRANSPORT METHOD:

This method involves in the direct transport of materials by evaporation or
sublimation from a hot source zone to a cool region II-VI compounds (Zns, Cds) are
widely grown by this method either in vaccum or with a moving gas stream. In both
cases the growth can be suitable with seed crystals, which can either be of the material
being grown or some other material with similar lattice spacing. In this case the
substance evaporates and diffuses from hot end to a cooler growth end. In then,
deposits in the form of single crystals.

[18]



ADVANTAGES:

 Films can obtain by the close spaced transport method and
decomposition of compounds.

 Crystal of silicon, diamond, gas, semiconductor compounds can be
grown by this method.

2.3.3 GROWTH FROM SOLUTION:

In this method, Crystals are grown from aqueous solution. This method is also
widely practiced for producing bulk crystals.The four major types are

 Low temperature solution growth
 High temperature solution growth
 Hydro Thermal growth
 Gel Growth

LOW TEMPERATURE SOLUTION GROWTH:

This is a widely practiced method.The techniques used here are,

 Slow cooling method
 Solvent Evaporation method
 Temperature Gradient method

SLOW COOLINGMETHOD:

A saturated solution above the room temperature is poured in a crystallizer and
thermally sealed. A seed crystal is suspended in the solution and the crystallizer is
kept in a water thermostat, whose temperature is reducing according to a pre assigned
plan, which results in the formation of large single crystals. The need to use a range of
temperature is the origin of 5751 disadvantages. The possible range is usually small
so that much of the solute remains in the solution at the end of run. To compensate for
this effect, large volumes of solution are needed.

[19]



SLOW EVAPORATION METHOD:

This method is similar to the slow cooling method in view of the apparatus
requirements. The temperature is fixed constant and provision is made for evaporation.
With non-toxic solvents like water, it is permissible to allow evaporation into the
atmosphere. Typical growth conditions involve temperature stabilization to about
± 0.005°C and rates of evaporation of a few ml/hr. The evaporation techniques of
crystal growth have the advantage that the crystals grow at a fixed temperature. But
inadequacies of the temperature control system still have a major effect on the growth
rate. This method is the only one, which can be used with materials, which have very
small temperature coefficient of stability. [15]

TEMPERATURE GRADIENT METHOD:

This method involves the transport of the materials from a hot region
containing the source material to be grown to a cooler region where the solution is
supersaturated and the crystal grows. The main advantages of this method are:

 Crystal grows at a fixed temperature.

 This method is insensitive to changes in temperature provided both the
source and the growing crystal undergo the same change.

 Economy of solvent and solute.

On the other hand, changes in the small temperature differences between the
source and the crystal zones have a large effect on the growth rate.

[20]



Excellent quality crystals of ferroelectric and piezo-electric materials such as
Ammonium dihydrogen phosphate (ADP), Potassium dihydrogen phosphate (KDP)
and Triglycine sulphate (TGS) are commercially grown for use in devices by the low
temperature solution growth method. Growth of crystal ranges from a small
inexpensive technique to a complex sophisticated expensive process and
crystallization time ranges from minutes, hours, days and to months. Single crystals
may be produced by the transport of crystal constituents in the solid, liquid or vapour
phase.

On the basis of this, crystal growth may be classified into three categories as
follows,

 Solid Growth - Solid-to-Solid phase transformation

 Liquid Growth - Liquid to Solid phase transformation

 Vapour Growth - Vapour to Solid phase transformation

[21]
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CHAPTER 3

CHARACTERISATION TECHNIQUES

3.1 INTRODUCTION:

Characterisation techniques include SEM( scanning electron microscopy),
TEM (transmission electron microscopy), X-ray diffraction, UV studies,FTIR, XRD,
X-ray fluorescence, NMR (nuclear magnetic resonance) and synchrotron techniques.

3.2 X-RAY DIFFRACTION:

XRD is a technique employed to determine the underlying crystal structure of
a material; it enables verification of the crystallinity and structure of a sample but
gives no information of a chemical nature. Fitting XRD patterns can allow calculation
of the material lattice parameters,the orientation of a crystal,stress in crystalline
regions,and secondary phases in the sample.It is generally a bulk characterization
technique and produces an average diffraction pattern for the area measured. XRD is a
non destructive technique which can be conducted at room temperature and
pressure.[12]

Since most materials have unique diffraction patterns,compounds can be
identified by using a database of diffraction patterns.The purity of a sample can also
be determined from its diffraction pattern,as well as the composition of any impurities
present. A diffraction pattern can also be used to determine and refine the lattice
parameters of a crystal structure. A theoretical structure can also be refined using a
method known as Rietveld refinement.The particle size of the powder can also be
determined by the powder can also be determined by using the Scherrer
formula,which relates the particle size to the peak width .

3.2.1 POWDER X-RAY DIFFRACTION ANALYSIS:

The analytical technique PXRD is used to determine the crystallinity degree or
amorphization of the examined samples.

[23]



In this technique ,sample preparation is not necessary and,unlike other
techniques, the sample does not change physiochemically after finishing the
technique.The methods used vary according to the material of analysis and equipment
used. The parameters used are typically 40-45 kV and 30-40 mA.

XRD or X- ray powder d+iffraction is an analytical technique widely used in
phase identification of crystalline structures and to determine the atomic
spacing.Crystalline structures act as a three dimensional diffraction grating for
X-ray. In the XRD machine,a cathode ray tube generates the X-ray then the X-ray is
filtered to produce monochromatic radiation and then collimated to hit the sample.The
beam then produces a constructive interference when it satisfies the Bragg’s Law. For
the powdered sample,the beam scans through a 2θ angle to cover all possible angles
of the sample.The diffracted beam is then processed to identify the material as every
crystal has a set of unique spacing.

3.2.2 FUNDAMENTALS OF X-RAY POWDER DIFFRACTION:

X-ray diffractometers consist of three basic elements: an X-ray tube, a
sample holder, and an X-ray detector. X-rays are generated in a cathode ray tube by
heating a filament to produce electrons, accelerating the electrons toward a target by
applying a voltage, and bombarding the target material with electrons. When electrons
have sufficient energy to dislodge inner shell electrons of the target material,
characteristic X-ray spectra are produced. These spectra consist of several
components, the most common being Kα and Kβ. Kα consists, in part, of Kα 1 and
Kα 2 . Kα 1 has a slightly shorter wavelength and twice the intensity as Kα 2 . The
specific wavelengths are characteristic of the target material (Cu, Fe, Mo, Cr).
Filtering, by foils or crystal monochrometers, is required to produce monochromatic
X-rays needed for diffraction. Kα 1 and Kα 2 are sufficiently close in wavelength such
that a weighted average of the two is used. Copper is the most common target material
for single-crystal diffraction. These X-rays are collimated and directed onto the
sample. As the sample and detector are rotated, the intensity of the reflected
X-rays is recorded. When the geometry of the incident X-rays impinging the sample
satisfies the Bragg Equation, constructive interference occurs and a peak in intensity
occurs. A detector records and processes this X-ray signal and converts the signal to a
count rate which is the output to a device such as a printer or computer monitor.

[24]



The geometry of an X-ray diffractometer is such that the sample rotates in
the path of the collimated X-ray beam at an angle θ while the X-ray detector is
mounted on an arm to collect the diffracted X-rays and rotates at an angle of 2θ. The
instrument used to maintain the angle and rotate the sample is termed a goniometer.
For typical powder patterns, data is collected at 2θ from ~5° to 70°, angles that are
preset in the X-ray scan.[11]

3.3 ULTRAVIOLET VISIBLE SPECTROSCOPY:

UV spectroscopy or UV–visible spectrophotometry (UV–Vis or UV/Vis)
refers to absorption spectroscopy or reflectance spectroscopy in part of the ultraviolet
and the full,adjacent visible regions of the electromagnetic spectrum.Ultraviolet-
visible (UV-Vis) spectrophotometry is a technique used to measure light absorbance
across the ultraviolet and visible ranges of the electromagnetic spectrum. When
incident light strikes matter it can either be absorbed, reflected, or transmitted. The
absorbance of radiation in the UV-Vis range causes atomic excitation, which refers to
the transition of molecules from a low - energy ground state to an excited state.

3.3.1 WAVELEGTH:

 Monochromators - A Monochromator separates light into a narrow band of
wavelengths. It is most often based on diffraction gratings that can be rotated to
choose incoming and reflected angles to select the desired wavelength of light.
The diffraction grating's groove frequency is often measured as the number of
grooves per mm. A higher groove frequency provides a better optical resolution
but a narrower usable wavelength range. A lower groove frequency provides a
larger usable wavelength range but a worse optical resolution. 300 to 2000
grooves per mm is usable for UV-Vis spectroscopy purposes but a minimum of
1200 grooves per mm is typical. The quality of the spectroscopic measurements is
sensitive to physical imperfections in the diffraction grating and in the optical
setup.

[25]



 Absorption filters - Absorption filters are commonly made of colored glass or
plastic designed to absorb particular wavelengths of light.

 Interference filters - Also called dichroic filters, these commonly used filters are
made of many layers of dielectric material where interference occurs between the
thin layers of materials. These filters can be used to eliminate undesirable
wavelengths by destructive interference, thus acting as a wavelength selector.

 Cutoff filters - Cutoff filters allow light either below (short pass) or above (long
pass) a certain wavelength to pass through. These are commonly implemented
using interference filters.

 Band pass filters -Band pass filters allow a range of wavelengths to pass through
that can be implemented by combining short pass and long pass filters together.

3.3.2 APPLICATION OF UV VISIBLE SPECTROSCOPY:

 UV absorption spectroscopy is used to determine the dissociation constants of
acids and bases. 

 UV absorption spectroscopy is generally used for the qualitative determination of
compounds that absorb UV. 

 UV absorption spectroscopy is one of the best methods for defecting impurities
in organic compounds. 

 UV absorption spectroscopy can characterize those type of compounds whiz
absorb UV radiation. 

 UV absorption spectroscopy can be used to study the kinetics of reaction.[18]

[26]



If the sample compound does not absorb light of of a given wavelength, 𝐼=𝐼0.
However, if the sample compound absorbs light then 𝐼 is less than 𝐼0 ,and this
difference may be plotted on a graph versus wavelength, as shown on the right.
Absorption may be presented as transmittance (T =𝐼/𝐼0) or absorbance (A= log𝐼0/𝐼). If
no absorption has occurred, T = 1.0 and A= 0. Most spectrometers display absorbance
on the vertical axis, and the commonly observed range is from 0 (100% transmittance)
to 2 (1% transmittance). The wavelength of maximum absorbance is a characteristic
value,designated as 𝜆𝑚𝑎𝑥.

Different compounds may have very different absorption maxima and
absorbances. Intensely absorbing compounds must be examined in dilute solution, so
that significant light energy is received by the detector, and this requires the use of
completely transparent (non-absorbing) solvent.The most commonly used solvents are
water, ethanol, hexane and cyclohexane. Solvents having double or triple bonds, or
heavy atoms (e.g. S, Br & I) are generally avoided. Because the absorbance of a
sample will be proportional to its molar concentration in the sample c known as the
molar absorptivity is used when comparing the spectra of different compounds.uvette,
a corrected absorption value.

This is defined as:
Molar Absorptivity = A/ c l

where A = absorbance,

c = sample concentration in moles/liter &

l = length of light path through the cuvette in cm.[19]

3.4 FOURIER TRANSFORM INFRARED SPECTROSCOPY:

Fourier Transform Infrared Spectroscopy (FTIR) is a powerful tool for
identifying types of chemical bonds in a molecule by producing an Infrared
absorption spectrum that like a molecular “finger print” Fourier Transform Infrared
Spectroscopy (FTIR) is an analytical technique used to identify organic (and in some
cases inorganic) materials. This technique measures the absorption of various infrared
light wave lengths by the material of interest. These Infrared absorption bands
identify specific molecular component and structures.

[27]



3.4.1 WORKING FOR FTIR PROCESS:

The normal instrumental process is as follows: 

The Source: Infrared energy is emitted from a glowing black-body source.This beam
passes through an aperture which controls the amount of energy presented to the
sample (and,ultimately,to the detector). 

The Interferometer: The beam enters the interferometer where the “spectral
encoding” takes place. The resulting interferometer signal then exits the
interferometer.

The Sample: The beam enters the sample compartment where it is transmitted
through or reflected off the surface of the sample, depending on the type of analysis
being accomplished. This is where specific frequencies of energy,which are uniquely
characteristic of the sample, are aborted.

The Detector: The beam finally passes to the detector to final measurement. The
Detectors used are specially designed to measure the special interfero-gram signal.

Advantages of FT-IR:

 Speed: All of the frequencies are measured simultaneously, most measurement
by FT-IR are made in a matter of seconds rather than several minutes.


 Sensitivity: It is dramatically improved with FT-IR for many reasons. The

detectors employed are much more sensitive, the optical throughput is much
higher results in much lower noise levels.


 Mechanical Simplicity: The moving mirror in the interferometer is the only

continuously moving part in the instrument.Thus there is very little possibility of
mechanical breakdown.

FT-IR technique has brought significant practical advantages to infrared
spectroscopy. It has possible the development of many new sampling techniques
which were designed to tackle challenging problems which were impossible by order
technology. It has made the use of infrared analysis virtually limitless.

Application of FTIR:

It can identify unknown materials. 

 It can identify variation.
 It can determine the quality of example.
 It can determine the amount of component in a mixture.FTIR is

much more sensitive.

[28]



3.4.2 WHERE IS FTIR SPECTROSCOPY USED FOR?

FTIR spectroscopy is used in organic synthesis, polymer science, petrochemical
engineering, pharmaceutical industry and food analysis. In other words, it has a wide
array of applications, from monitoring processes to identifying compounds to
determining components in a mixture.

HOWDOES FTIR WORK?

A molecule’s covalent bonds will selectively absorb radiation of specific
wavelengths, which changes the vibrational energy in the bond. The type of vibration
(stretching or bending) induced by the infrared radiation depends on the atoms in the
bond. Because different bonds and functional groups absorb different frequencies, the
transmittance pattern is different for different molecules. (Transmittance is the flip
side of absorbance).The spectrum is recorded on a graph with wave number (𝑐𝑚−1 )
recorded on the X-axis and transmittance recorded on the Y-axis. (Wave number is
1/wavelength and corresponds to the energy of the vibration of the molecular bonds).

3.4.3 HOW TO READ AN FTIR SPECTRUM?

Reading the spectrum is a matter of determining which groups and bonds
correspond to which peaks.

 The X-Axis: The Infrared Spectrum. The x-axis-or horizontal axis-represents the
infrared spectrum, which plots the intensity of infrared spectra.

 The Y-Axis: Absorbance or Frequency.

 The Absorbance Bands.

[29]
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CHAPTER-4

RESULTS AND DISCUSSION

4.1 INTRODUCTION:

This chapter deals with the growth of CuSO₄ doped Urea and MgSO₄ by
slow evaporation solution technique and characterization of the grown crystals.The
results obtain from XRD analysis, FTIR spectral analysis and UV studies are reported
and discussed in this chapter.

4.2 EXPERIMENTAL PROCEDURE:

Growth of CuSO₄ doped Urea and MgSO₄ :

Growth of CuSO₄ doped Urea and MgSO₄ were grown by slow evaporation
solution technique at room temperature. Saturated solution was prepared by mixing
the salt with demineralised water.To obtain homogeneous solution it was stirred using
magnetic stirrer for about two hours. Then the saturated solution was filtered using
whatman filter paper.The filtered solution was then transferred to separate borosil
glass beaker covered with porous paper with controlled evaporation.The good quality
doped crystals were harvested within a period of 10-15 days. The experimental set up
is in the figure: 4.2.1a and 4.2.1b. Grown single crystals are photographed and shown
in the figure: 4.2.2a and 4.2.2b

Figure 4.2.1a Experimental set up Figure 4.2.1b Experimental set up

Figure: 4.2.2a Photograph of CuSO₄ doped Figure: 4.2.2b Photograph of CuSO₄
Urea crystal doped MgSO₄ crystal
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4.3 POWDER X-RAY DIFFRACTION ANALYSIS:

The grown crystals have been crushed into uniform fine powder and subjected
to powder X-ray diffraction to identify the reflection planes. Advanced PAN
analytical XPERT PRO diffractrometer was used to record the diffraction pattern of
the grown sample with CuKα (λ=1.54056 Å). The sample was scanned over the
required 2θ range of 10˚- 30˚. X-ray diffraction data gives the angle of scattering (2θ)
and the corresponding intensities of diffracted beam for each reflection. All the
reflections of powder XRD pattern of the grown crystals were indexed using
INDEXING software package following of the procedure of C.Lipson and
Steeple(1970). Indexing of the powder pattern consists of assignment of the numbers
h,k,l (miller indices) to each reflection. The indexed powder X-ray diffraction pattern
of the grown crystals are shown in figure: 4.3.1 and 4.3.2.The occurrence of sharp
peaks at specific Bragg’s angles gives surety of high crystallinity of Urea and MgSO₄
doped with CuSO₄.

Figure: 4.3.1 shows the X-ray diffraction pattern of CuSO₄ doped
MgSO₄.The diffraction pattern shows sharp deflection corresponding to orthorhombic
structure.The Powder XRD pattern from the grown crystals with high intensity peaks
were observed at

2θ= 16.6700 along the (210) h, k, l plane
2θ= 19.8112 along the (121) h, k, l plane
2θ= 21.1803 along the (211) h, k, l plane
2θ= 33.7610 along the (312) h, k, l plane

From the above observation it is understood that the doped crystal exhibits
orthorhombic structure as confirmed from the JCPDS file: 75-0673. The absence of
impurities peak reveals that the grown crystals exhibit high crystalline quality. Using
β as Full Width at Half Maximum (FWHM) of a broad diffraction peak,average grain
size is estimated by applying the

Scherrer’s equation:
D= Kλ/β cos θ

Where K= 0.9 (Scherrer’s constant)
λ is X-ray wavelength
θ is Diffracted angle
β is Full Width at Half Maximum(FWHM)

The average particle size obtained from XRD data is found to be 79.10 nm

[32]



Figure:4.3.1 POWDER XRD PATTERN FOR CuSO₄ DOPED MgSO₄
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Table:4.3.1a Powder XRD data for CuSO₄ doped MgSO₄

Table:4.3.1b Crystallographic data (PXRD) for CuSO₄ doped MgSO₄

CRYSTAL PARAMETERS CuSO₄ DOPED MgSO₄
a (Å) 15.261 (Å)
b (Å) 22.68 (Å)
c (Å) 5.143 (Å)
System Orthorhombic

Figure: 4.3.2 shows the X-ray diffraction pattern of CuSO₄ doped Urea. The
diffraction pattern shows sharp deflection corresponding to tetragonal structure. The
Powder XRD pattern from the grown crystals with high intensity peaks were observed
at

2θ= 22.66 along the (110) h, k, l plane
2θ= 24.68 along the (101) h, k, l plane
2θ= 29.45 along the (111) h, k, l plane
2θ= 31.83 along the (200) h, k, l plane
2θ= 35.74 along the (201) h, k, l plane
2θ= 37.41 along the (002) h, k, l plane
2θ= 54.02 along the (311) h, k, l plane

From the above observation it is understood that the doped crystal exhibits
tetragonal structure as confirmed from the JCPDS file: 31-1979. The absence of
impurities peak reveals that the grown crystals exhibit high crystalline quality. Using
β as Full Width at Half Maximum(FWHM) of a broad diffraction peak,average grain
size was estimated by applying the Scherrer’s equation and is reported to be 42.12 nm.

[33]

S.NO 2θ degree d-spacing Å h k l
1. 16.6700 5.3121 2 1 0
2. 19.8112 4.476 1 2 1
3. 21.1803 4.1904 2 1 1
4. 33.7610 2.6517 3 1 2



Figure:4.3.2 POWDER XRD PATTERN FOR CuSO₄ DOPED UREA
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Table:4.3.2a Powder XRD data for CuSO₄ doped Urea

S.No 2θ (degree) d-spacing (A˚) h k l
1. 22.66 3.9205 1 1 0
2. 24.68 3.6031 1 0 1
3. 29.45 3.0297 1 1 1
4. 31.83 2.8081 2 0 0
5. 35.74 2.5097 2 0 1
6. 37.41 2.4013 0 0 2
7. 54.02 1.6956 3 1 1

Table:4.3.2b Crystallographic data (PXRD) for CuSO₄ doped Urea

CRYSTAL PARAMETERS CuSO₄ DOPED UREA
a (Å) 5.544 (Å)
b (Å) 5.544 (Å)
c (Å) 5.918 (Å)
System Tetragonal

4.4 UV SPECTRA OF COPPER SULPHATE DOPED MAGNESIUM
SULPHATE AND UREA

UV spectra was recorded using a Shimadzu double beam spectrometer in the
wavelength 200nm- 800 nm. λmax for CuSO₄ appears at 635 nm as per reported
literature and reported UV spectra of urea is also shown below. It can be observed that
copper sulphate doped urea (Fig:4.4.1) shows a peak at 779 nm thereby clearly
indicating the insertion of CuSO₄ in the lattice sites. In the case of copper sulphate
doped magnesium sulphate (Fig:4.4.2) characteristic peak for copper is not observed
probably that the copper has not been adsorbed into the lattice sites.

[34]



Fig:4.4.1 UV Spectra of Copper sulphate doped Urea

Fig:4.4.2 UV Spectra of Copper sulphate doped Magnesium sulphate

4.5 FTIR SPECTRA OF COPPER SULPHATE DOPED MAGNESIUM
SULPHATE AND UREA

FTIR spectrum of reported MgSO₄.7H₂O shows characteristic O-H stretching
band at 3271.27 𝑐𝑚−1 and O-H bending vibrational band at 1647.21 𝑐𝑚−1 .The
absorption band at 1064.71 𝑐𝑚−1 corresponds to SO₄−2 stretching vibration, and the
band at 981.77 𝑐𝑚−1 is due to SO₄−2bending vibration. The bands at 661.85 𝑐𝑚−1

and 605.65 𝑐𝑚−1 is attributed MgO group.

The infrared spectrum of CuSO₄·5H₂O shows peaks at 3420 𝑐𝑚−1 and
1667 𝑐𝑚−1 assigned for O-H stretching and bending modes, respectively, for copper
sulfate pentahydrate.

In the case of urea N-H stretching occurs at around 3500 𝑐𝑚−1 , C=O around
1750 𝑐𝑚−1 , N-H deformation at around 1600 𝑐𝑚−1 and C-N around 1400 𝑐𝑚−1 .In
copper sulphate doped urea Fig:4.5.1 additional peaks arise at 3446 𝑐𝑚−1

corresponding to O-H stretching mode of water in copper sulphate pentahydrate, one
at 1679 𝑐𝑚−1 due to O-H bending in copper sulphate pentahydrate 2470 𝑐𝑚−1 which
is a clear indication that CuSO₄ is adsorbed into the lattice sites.

Similarly in copper sulphate doped magnesium sulphate Fig:4.5.2 there are not
much changes in the stretching indicating the absence of incorporation of copper
sulphate.

[35]



Fig:4.5.1 FTIR spectra of Copper sulphate doped Urea

Fig:4.5.2 FTIR Spectra of Copper sulphate doped Magnesium sulphate
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CHAPTER-5

CONCLUSION

This project work was aimed to grow CuSO₄ doped Urea and Magnesium
sulphate crystals and to characterize the grown crystals by various studies. The
following conclusions are drawn from the results of the studies.

 CuSO₄ doped Urea and Magnesium sulphate were grown by slow
evaporation solution technique at room temperature. The crystal is found
to be stable and of good quality.

 The grown crystals were subjected to powder XRD analysis and all the
prominent peaks were indexed. From the experimental data, it is
observed that the doped Urea belongs to tetragonal system and doped
Magnesium sulphate belongs to orthorhombic system.Crystal parameters
and average grain size of the particle were also determined.

 The UV-visible transmission analysis and Fourier Transform Infrared
(FTIR) analysis were also done. Additional peaks were observed in
CuSO₄ doped Urea showing the presence of incorporation of Copper
whereas, it was observed in both UV and FTIR analysis the absence of
incorporation of Copper in CuSO₄ doped MgSO₄.

[38]
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ABSTRACT 

 
The 3D modeling is one of the crucial topics that are still under 

analysis by many engineers and programmers because of the 

great advancements in data acquisition technologies and 3D 

computer graphics programming. To achieve that goal, the city 

Thoothukudi, located in Tamilnadu was chosen as a case study. 

The minimum data requirements to generate a 3D city model are 

the terrain, 2D spatial features such as buildings, landscape area 

and street networks. Moreover, building height is an important 

attribute in the 3D extrusion process. First, the terrain was 

obtained from a Digital Elevation Model (DEM). Second, 2D 

data were obtained. To present terrain characteristics of 

Thoothukudi especially relief zoning, aspect analysis, hill shade 

view, slope, sieve etc… Covid 19 pandemic in India statistics is 

simulated as an application of terrain analysis on the generated 

3D city model. It is reported that, this study is very valuable in 

mapping and computing the total Covid 19 cases in the city. 
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1. Introduction: 

Terrain Analysis is the analysis and interpretation of topographic features 

through geographic information systems. Such features include slope, aspect, view 

shed, elevation, contour lines, flow lines, up slope flow lines and down slope flow 

lines. It is the study of the nature, origin, morphological history and composition of 

land forms, the result of which is a land form or land component map. It employs 

elevation data, usually in conjunction with other geospatial information, to 

describe the landscape, for basic visualization, modeling, or to support decision 

making. The collection, analysis, evaluation, and interpretation of geographic 

information on the natural and manmade features of the terrain, combined with 

other relevant factors, to predict the effect of the terrain on military operations. The 

terrain of a region largely determines its suitability for human settlement. 

 

The intention is to build mathematical abstraction of surface terrain in order to 

delineate or stratify landscapes and create an understanding of relationships 

between ecological processes and physical features.  

 

Geographic information systems (GIS) applications are moving towards 3D, as it 

has the capacity to better represent the real world. Currently most of these 

applications can be run in online environments. The emerging of geo-browsers 

such as Google Earth, Microsoft Virtual Earth, and World Win, made the demands 

for these kinds of applications increase tremendously. 3D terrain visualization is a 

most important part of this technology. They require both the terrain rendering and 

the geo-spatial data visualization to identify and analyze important features in the 

data. Features refer to subsets of data that are of particular interest, such as certain 

mountainous structures, specific weather conditions, or objects of interest. It is 

important to effectively communicate these features and, therefore, customized 

presentations are required. The digital elevation model (DEM), an important 

source of information, is usually used to express a topographic surface in three 

dimensions and to imitate essential natural geography. 
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Applications of QGIS provide opportunities for modeling, analyzing and 

displaying geographical phenomena connected with topography and relief. The 

utility of the DEM is evidenced by the widespread availability of digital 

topographic data and ever- increasing applications of DEM. They have been found 

useful in many fields of study such as terrain analysis. Terrain and slope analysis, 

globally, are used for demarcating sites of sedimentation, stable zones, etc., which 

ultimately provide important data to develop final remedy structures and to deliver 

solutions for various environmental problems. DEMs are being used for a wide 

variety of scientific and commercial purposes. 
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2. LITERATURE REVIEW 

Bi Le Wan, Wen Xing He and Chang Yu Chen (2016) proposed a method of 

structural process design based on 3D model. The paper focused on designing a 

peculiar 3D assembly method meeting the demands of spacecraft. Firstly, an 

assembly digital mock-up (ADMU) was constructed. Second, they proposed the 

way of assembly process design on 3D structural process design scheme. Finally, 

the paper describes the application of the technology, and analyses the effect of the 

scheme during a satellite development. Furthermore, using uniform data source 

from assembly digital mock-up and analyzing two essential criteria about 

digitization assembling spacecraft, the solution was proposed for structured 

process design, working process and system framework about assembling 

spacecraft. Combined with the actual case demonstration it had a good application 

outcome.    

Vladimir M. Petrovic, Dragan Zlatanovic, Mirko Borisov, Lidija Djurdjevac 

Ignjatovic (2016) described the concepts of 3D terrain models and their 

application in mining. Mining basins and open pit mines have a specific 

topography. Their features are sudden transition of relief features, both spatial and 

in time, which is interesting for analysis and interpretation of surveying data i.e. 

terrain modelling in function of time. Thereby available technology enables 

integration of different surveying instruments and technologies into single system, 

in order to obtain accurate and reliable information and to link those with 

operational efficiency. There is a need for frequent acquisition of profiles, 

calculation of earth volumes, review of maximal inclination, creation of future 

terrain interpretations and configuration, optical visibility and similarity. Having 

all this in mind, as well as frequent changes in terrain surface in time, the concept 



4 
 

of digital terrain modelling provides large methodological and technological 

capabilities for research and execution of the mining activities.   

Giacomo Landeschi,Björn Nilsson, Nicolo Dell’Unto(2016) focuses entirely on 

the amount of damage made by both the vehicle and the illegal metal detection. 

One of the main goals of this study was to test a heuristic approach towards the use 

of 3D GIS in the excavation practice. For this reason, three different phases of an 

archeologically excavation have been documented through a combined use of 

image-based 3D reconstruction techniques and GIS tools. The present research has 

sought to demonstrate how 3D models can be effectively used in field archaeology 

as a means for land evaluation and risk assessment. The rescue archaeology is the 

dominant form of field archaeology and there is a lot of work done with the 

purpose of legally protecting the cultural heritage. In this respect it becomes 

extremely important to benefit from the use of advanced quantitative methods that 

can provide archaeologists with a more objective insight into the situation observed 

in the field. Additionally, the adoption of formal methods of analysis and site 

evaluation that heavily rely on 3D as a further source of information should be 

included and fostered as an additional means for assessing those archaeological 

sites at risk of degradation or threatened by ongoing conflicts and wars. 

Davis Dinkov, Rumiana Vatseva(2016) presented cartographic applications of 

3D landscape modelling and visualization for tourist maps protected areas 

monitoring. The study was focussed on technical approaches for data modelling; 

cartographic design and practical use of the created 3D maps.3D landscapes were 

developed and visualized using specialized GIS software that allows modelling the 

real landscape in very high level of details. Various visualization techniques were 

illustrated for basic landscape features types and 3D cartographic symbols. The 

applied approach facilitated an attractive representation of 3D geovirtual 
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environment and realistic visualization by 3D panoramic maps. It offered an 

effective means for visual communication of 3D spatial information. Creation of 

3D models and 3D maps were generated at different levels of detail and 

generalization according to user demands. The whole mapping process is aimed at 

better understanding not only of the modelling techniques, but also of the end user 

requirements. This emphasized the high degree of customization with respect to 

cartographic design and applications. The present work highlights the need for 

more study to be done on the efficient presentation of geospatial information by 

providing additional context within a 3D maps. 

Abdulla Al-Rawabdeh, Nadhir Al-Ansari, Hussain Attya and Sven 

Knutsson(2014) discussed the concept of 3D GIS modeling techniques using a 

simple procedure to generate a university campus model which showed the 

effectiveness of this approach. The 3D GIS model provides access to mapping data 

to support planning, design and data management. The primary objective was to 

improve data management (e.g., maps, plans, usage of facilities and services) and to 

develop methods using 3D spatial analysis for specific applications at the 

university.3D GIS provides urban designers and planners with a useful tool for 

modeling and analysis. The 3D GIS application was developed in order to evaluate 

urban space efficiently and to provide information about urban planning to local 

communities. This application enables users to visualize complicated urban planning 

information in the 3D way, to evaluate the allowable capacity of the block and to 

stimulate building plans. With visualization and analysis capability, 3D GIS are 

considered a powerful tool to solve various issues which modern cities confront.  

Rahul S. Jain, Pradhir D. Parmar, Dhruvesh P. Patel (2017) discussed all 

techniques and their usefulness in 3D city model creation from the GCP, base map, 

SRTM and QGIS. Planning and drawing is the important aspect of civil 
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engineering. For testing theories about spatial location and interaction between 

land uses and related activities the computer based solution of urban models are 

used. The planner’s primary interest is in creation of 3D models of building and to 

obtain the terrain surface so that he can do urban morphological mappings, virtual 

reality, disaster management, fly through generation, visualization etc. This study 

was carried out to demonstrate a procedure for generating the 3D model of city 

using the master plan and the GCP points with the help of the open source software 

QGIS. With the rapid development of urban city, 3D models of city have become 

necessary to be generated to know the future development of the city. We believe 

that this research is important to the urban city planner, to generate the 3D model 

of city before constructing the city so as the effect of earthquake, flood, rain, etc. 

can be determined and accordingly preventive measures can be taken to reduce the 

loss due to them. 

Fuzal Ahmed and K.Srinivasa Rao (2019) demonstrated the applicability of 

remote sensing, DEM data and GIS tools for basin analysis with reference to the 

tectonics. They studied about the Tuirini River that drains over an area of about   

420 sq.km. The study shows that, most of the tributaries originate from the high 

altitude and show more or less straight courses due to the structural effect. The 

terrain is tectonically active as supported by the existence of number of lineaments, 

fractures and faults. Thus the study concluded that the remotely sensed data and 

DEM data coupled with GIS techniques recognized to be a competent tool in terrain 

analysis, which would be helpful in various development activities and conservation 

of natural resources of the basin area.   

Kartik R. Kulkarni, Yatish C. H., Kiran P.Kamble, Ashish A.Kulkarni, 

Shashank C. Bangi(2017) worked on the campus of K.L.S Gogte Institute of 

Technology which is located in Udyambag Belagavi. The objective of this study was 



7 
 

to create the2D map and 3D model of the campus and to present the current status 

using the GIS concept. The aim of this project was to show how software’s like 

google earth, SketchUp and QGIS can be used to represent 2D and 3D environment 

with more reliability, accuracy and less time. In this work the technique employed 

was simple and user friendly, time effective and cost effective. The technique 

employed in this study has given the good results with higher accuracy. 

Edon Maliqi, Petar Penev, Faik Kelmendi (2017) aimed in developing the 

Digital Terrain Model (DTM) through QGIS software. They concluded that QGIS 

software was appropriate software for creating, analyzing, interpreting and 

visualization the DTM and geo-spatial data in general. It was easy for generating 

the DTM using this software. QGIS software supports some methods and 

techniques of generating DTM. In the paper are proved TIN and GRID methods 

and some of visualization techniques of DTM like contour lines, hillshading and 

perspective view. All methods and techniques have advantages and disadvantages 

between each other. A disadvantage of QGIS software was it does not 

allow/support improving of DTM created for example we cannot improve 

connection of triangles according logical way to TIN. Also it has some choices to 

visualize the DTM.  

B. G. Kodge (2020) aimed to study the current scenario of COVID19 cases in 

Maharashtra state using the geo-visualization techniques. The paper deals with the 

district wise current situations showing through compiled maps of COVID19 cases 

and also presents the detailed ward wise map of COVID19 cases of Mumbai city 

which has the highest number of cases in Maharashtra state. The information was 

generated geographically and presented the covid status. The results provided in 

this paper are the evidences showing the current status of COVID19 cases in 

Maharashtra state of India. The infected cases were increasing on one side, on 
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another side the numbers of recovered cases were also increasing. But at the same 

time the deceased cases were also increasing enormously. The results published in 

this paper are subject to change in due course of time. 

Xun Shi, Lyndsey Girod, Robert Long, Roger DeKett, Jessica Philippe, Tom 

Burke (2012) compared the performance of Lidar-based DEM and the USGS-

sourced DEM in calculating slope gradient as an input for knowledge based digital 

soil mapping, aimed to provide scientific evidence and proposed a scientific 

approach to evaluate the two types of DEM for KBDSM. The findings of this study 

are summarized as follows: (1) In terms of matching the field-measured values, the 

LiDAR-based DEM performed considerably and consistently better than the USGS-

sourced DEM. Particularly, at the 30-m neighborhood, the “error” measured by 

MAE was reduced by about 50% when using LiDAR- based DEM.(2) In terms of 

matching the field-measured values, the results from the resampled 5-m LiDAR-

based DEM only differed slightly from those from the 1-m LiDAR-based DEM, and 

for the smaller neighborhood (10 m),the 5-m DEM even performed better than the 1-

m DEM.(3) On a smaller measuring neighborhood (10m), the mismatch between the 

DEM-based and the field-measured values are greater than that on a lager measuring 

neighborhood (30 m). (4) On a larger neighborhood, the methods using the circular 

neighborhood performed better than the methods using the conventional square 

neighborhood. (5) On gentle slopes, the DEM-based values tended to overestimate 

the field-measured values, whereas on steep slopes, the DEM-based values tended 

to underestimate the field-measured values, and 20% (slope gradient) seems to be 

the turning point. This study only tested one terrain attribute (although it is an 

important one in soil-landscape modeling) and only worked on one small 

watershed. The study found that the results from the 1-m LiDAR based DEM and 

the resampled 5-m DEM do not show considerable and consistent differences.  
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Anjali G Pillai, Ashna K N (2015) dealed with employing IDW interpolation 

techniques in carrying out precipitation interpolation of Kozhikode district in Kerala, 

India using QGIS and assessing the output to understand the general trend of rainfall 

pattern seen in that area. Rainfall maps of 2010 and 2014 were compared and overall 

decrease in the precipitation amount was observed. Further the use of QGIS software 

for carrying out this project further enables the promotion of this freeware. At 

reduced cost and with comparable efficiency the tasks can be performed very easily 

for obtaining appropriate outputs for various research oriented projects. The results 

of this project can be utilized for creating inputs for various hydrological models 

which can be considered as the suitable future scope of development.     

Zhou Li, Sun Jia-long, Li Wei-xiao, Bai He, Chen Wei-wei (2008) discussed the 

object-oriented 3D modeling technique to use existing digital photogrammetric 

software platform for secondary development. The text includes: the object-

oriented concept of 3D modeling; the 3D GIS modeling technology based on 

digital photogrammetry; the Digital Campus examples of 3D modeling over the 

current Digital Campus space modeling, using the methods of divide entities and 

management-oriented data modeling to combine the 3D model of the campus and 

the database management objectives, achieve the 3D model of the campus on the 

school's Information Management Services Digital and inquiry friendly the 

accurate information. This paper puts stress on discussing the inquiring for detail 

information of entity, however nowadays it is very difficult to skim in 3D model 

through the material inside of entity which will need more much time and great 

effort to deal with.         
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3. STUDY AREA  

 

Thoothukudi district is in the Indian state of Tamil Nadu. The city lies in 

the Coromandel Coast of Bay of Bengal. The study area is located at 

8.53°N 78.36°E in South India, on the Gulf of Mannar, about 540 

kilometres (340 miles) south of Chennai and 125 kilometres (78 miles) 

north of Kanyakumari. The hinterlands of the port of the city are 

connected to the districts of Madurai, Tirunelveli, Ramanathapuram and 

Tiruchirapalli. 
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The city has a very high humidity being in the coastal sector. The 

topographic elevation of the watershed varies from 27.00 m (amsl) in the 

catchment area to few meters (amsl) near the coast and slopes from west 

to east. The slope is gentle in western and central parts and more or less 

plain in eastern part of the watershed. The area experiences semi-arid 

tropical climatic condition and the long term average annual rainfall is 

568 mm. In Thoothukudi District Thamirabarani River, Vaippar River, 

and their tributaries are draining and passing through the District. The 

Thamirabarani river is perennial in nature. Thoothukudi district has 

consist of eight taluks such as Thoothukudi, Srivaikundam, Kovilpatti, 

Ettayapuram, Vilathikulam, Ottapidaram, Thiruchendur and 

Sathankulam) with total population of 17, 50,176 (as per 2011 census). 

The district is divided into 12 blocks for rural and urban development 

such as Tuticorin, Thiruchendur,  Udangudi, Sathankulam, 

Srivaikundam, Alwarthirunagari, Karunkulam, Ottapidaram, Kovilpatti, 

Kayathar, Vilathikulam, and Pudur.  
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4. METHODS AND MATERIALS 

4.1. QGIS 

QGIS functions as geographic information system (GIS) software, allowing users 

to analyze and edit spatial information, in addition to composing and exporting 

graphical maps. QGIS supports raster, vector and mesh layers. Vector data is 

stored as point, line, or polygon features. Multiple formats of raster images are 

supported and the software can geo-refer images. 

 

 

 

 

In this project we have used QGIS version 3.22.4 which includes a vast number of 

user experience enhancements and controls added to various advanced 

functionalities. In addition to a host of additional mesh functionality and 

operational improvements. 

 

4.2. DATA COLLECTION 

 

4.2.1. Vector DATA 

Vector data provide a way to represent real world features within the GIS 

environment. Vector features have attributes, which consist of text or numerical 

information that describe the features. A vector feature has its shape represented 

https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/Raster_graphics
https://en.wikipedia.org/wiki/Vector_graphics
https://en.wikipedia.org/wiki/Polygon_(computer_graphics)
https://en.wikipedia.org/wiki/Georeferencing
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using geometry. The geometry is made up of one or more interconnected vertices. 

A vertex describes a position in space using an X, Y and optionally Z axis. 

 

             

                          Select Layer > Add Layer > Add Vector Layer 

The vector data was downloaded from the web page DIVAGIS. All the shape files 

were added to the QGIS software.   

 

4.2.2. Raster DATA 

A raster layer consists of one or more raster bands — referred to as single band and 

multi band raster’s. One band represents a matrix of values. Raster data is like any 

image. Although it may portray various properties of objects in the real world, 

these objects don’t exist as separate objects; rather, they are represented using 

pixels of various different color values. 

The raster data was downloaded as an individual tile from the website BHUVAN 

and was added in the QGIS. 

      Select Layer > Add Layer > Add Raster Layer 

A digital elevation model is a bare-earth raster grid referenced to a vertical datum. 

The non-ground points such as built (power lines, buildings and towers) and 

natural (trees and other types of vegetation) aren’t included in a DEM.       
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Merge 

The raster tiles downloaded from BHUVAN is merged in QGIS. The merge layers 

tool merges features from multiple layers into a single shape file and adds the 

merged shape file to the project.   

Select Raster > Miscellaneous > Merge. 

 

 

Mask 

Masking is a technique used to clarify dense or detailed map content by having the 

features of one layer hide, or mask, features of another layer where they overlap.   

     Select Raster > Extraction > Clip Raster by Mask Layer  
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4.3. TERRAIN ANALYSIS 

 

4.3.1. ASPECT 

 

Aspect is the compass direction that a slope faces. The pixels will have a value 

from 0-360 degrees measured in degrees from north indicating the azimuth. Aspect 

values indicate the directions the physical slopes face. We can classify aspect 

directions based on the slope angle with a descriptive direction. An output aspect 

raster will typically result in several slope direction classes. Aspect identifies the 

down slope direction of the maximum rate of change in value from each cell to its 

neighbors. Aspect can be thought of as the slope direction. The values of the output 

raster are the compass direction of the aspect. Aspect is measured 

counterclockwise in degrees from 0 (due north) to 360(again due north, coming 

full circle). The value of each cell in an aspect grid indicates the direction in which 

the cell’s slope faces. Flat slopes have no direction and are given a value of -1. An 

aspect-slope map simultaneously shows the aspect (direction) and degree 

(steepness) of slope for a terrain (or other continuous surface). The values of the 

output raster will be the compass direction of the aspect, represented by a hue 

(color). 

 

Parameters 

Label Name Type Description 

Input layer INPUT [raster] Input elevation raster layer 



16 
 

Band 

number 
BAND 

[raster 

band] 

Default: 1 

The number of the band to 

use as elevation 

Return 

trigonometri

c angle 

instead of 

azimuth 

TRIG_AN

GLE 

[boolean] 

Default: 

False 

Activating the 

trigonometric angle results 

in different categories: 0° 

(East), 90° (North), 180° 

(West), 270° (South). 

Return 0 for 

flat instead 

of -9999 

ZERO_FL

AT 

[boolean] 

Default: 

False 

Activating this option will 

insert a 0-value for the 

value -9999 on flat areas. 

 

 

4.3.2. Hill shade 

 

Hill shading is a technique for visualizing terrain determined by a light source and 

the slope and aspect of the elevation surface. The hill shade function produces a 

grayscale 3D representation of the terrain surface, with the sun's relative position 

taken into account for shading the image. It is a technique where a lighting effect is 

added to a map based on elevation variations within the landscape. A hill shade can 

provide very useful information about the sunlight at a given time of day. But it 

can also be used for aesthetic purposes, to make the map look better. The key to 
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this is setting the hill shade to being mostly transparent. Hill shading is a technique 

used to create a realistic view of terrain by creating a three-dimensional surface 

from a two-dimensional display of it. Hill shading creates a hypothetical 

illumination of a surface by setting a position for a light source and calculating an 

illumination value for each cell based on the cell's relative orientation to the light, 

or based on the slope and aspect of the cell. The hill shade layer contains values 

from 0 (complete shadow) to 255 (complete sun). Hill shade is used usually to 

better understand the relief of the area. 

 

Parameters    

LABEL  NAME  TYPE DESCRIPTION 

Elevation layer INPUT  [raster] 
Digital Terrain Model raster 

layer 

Z factor Z_FACTOR  

[number] 

Default: 

1.0 

Vertical exaggeration. This 

parameter is useful when the Z 

units differ from the X and Y 

units, for example feet and 

meters. You can use this 

parameter to adjust for this. 

Increasing the value of this 

parameter will exaggerate the 

final result (making it look 

more “hilly”). The default is 1 

(no exaggeration). 

Azimuth 

(horizontal angle) 
AZIMUTH  

[number] 

Default: 

300.0 

Set the horizontal angle (in 

degrees) of the sun (clockwise 

direction). Range: 0 to 360. 0 is 

north. 

Vertical angle V_ANGLE  

[number] 

Default: 

Set the vertical angle (in 

degrees) of the sun , that is the 

height of the sun. Values can 



18 
 

Parameters    

LABEL  NAME  TYPE DESCRIPTION 

40.0 go from 0 (minimum elevation) 

to 90 (maximum elevation). 

Hill shade OUTPUT  [raster] 

Specify the output hill shade 

raster layer. One of: 

 Save to a Temporary Layer 

( TEMPORARY_OUTPUT

) 

 Save to File… 

The file encoding can also be 

changed here. 

 

4.3.3. SLOPE 

 

 A slope map is a topographic map showing changes in elevation on a highly 

detailed level. Architects, landscape designers, and water control planners use a 

slope map to evaluate a particular site. Slope is the angle of inclination to the 

horizontal. The slope tool identifies the steepness at each cell of the raster surface. 

The lower the slope value, the flatter the terrain; the higher the slope value, the 

steeper the terrain. Detailed data are required to generate one of these maps. In 

QGIS this tool can be found under ‘Raster’-> ‘Terrain Analysis’-> ‘Slope’, in the 

menu bar at the top. As input it requires our DEM raster file. The slope of any line 

remains constant along the line. The slope tells the information about the direction 

of the line on the coordinate plane. It is important for the farmer or irrigator to 

identify the slopes on the land. A slope is easy to recognize in a hilly area. 

 

Parameters 
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Label Name Type Description 

Input layer INPUT [raster] 
Input Elevation 

raster layer 

Band number BAND 

[raster 

band] 

Default: 

1 

Band containing 

the elevation 

information 

Ratio of vertical 

units to horizontal 
SCALE 

[number

] 

Default: 

1.0 

The ratio of vertical 

units to horizontal 

units 

Slope expressed as 

percent (instead of 

degrees) 

AS_PERC

ENT 

[boolea

n] 

Default: 

False 

Express slope as 

percent instead of 

degrees 

Compute edges 
COMPUTE

_EDGES 

[boolea

n] 

Default: 

False 

Generates edges 

from the elevation 

raster 
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Use 

Zevenbergen&Thorn

e formula (instead of 

the Horn’s one) 

ZEVENBE

RGEN 

[boolea

n] 

Default: 

False 

Activates 

Zevenbergen&Thor

ne formula for 

smooth landscapes 

Slope OUTPUT 

[raster] 

Default: 

[Save to 

tempora

ry file] 

Specify the output 

raster layer. One of: 

● Save to a 

Temporar

y File 

● Save to 

File… 

 

4.3. 4.SIEVE 

 

‘Sieve’ is a constraints and opportunities mapping process that builds up a number 

of geographical layers to produce a visual presentation of areas that show less(or 

more) potential for future settlement growth. The process of ‘Sieve Mapping’ as a 

planning tool, indicating that it ‘constituted a most valuable means of summarizing 

and analysis survey data’. These maps are overlain on a base map and on each 

other to reveal areas not subject to any constraints. Using overlays rather than 

redrawing all the constraints on a single composite map has the advantage that 

overlays can be used in any combination. Sieve removes polygons smaller than a 

provided threshold size (in pixels) and replaces them with the pixel value of the 

largest neighbor polygon. It is useful if we have a large amount of small areas on 

our raster map. 
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Parameters 

Label Name Type Description 

Input layer INPUT [raster] 
Input elevation raster 

layer 

Threshold THRESHOLD 

[numbe

r] 

Default

: 10 

Only raster polygons 

smaller than this size 

will be removed 

Use 8-

connectednes

s 

EIGHT_CONN

ECTEDNESS 

[boolea

n] 

Default

: False 

Use eight 

connectedness instead 

of four connectedness 

Do not use 

the default 

validity mask 

for the input 

band 

NO_MASK 

[boolea

n] 

Default
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: False 

Validity mask 

Optional 

MASK_LAYER [raster] 
Validity mask to use 

instead of the default 

Sieved OUTPUT 

[raster] 

Default

: [Save 

to 

tempor

ary file] 

Specify the output 

raster layer. One of: 

● Save to a 

Temporary 

File 

● Save to 

File… 

 

4.3.5. Contour 

Contour is a height isoline. Isoline is a line on a map with a constant value. 

Therefore the contour definition is a line which has a constant elevation along the 

line. There are some characteristics of contour line such as contour interval, 

contour elevation and distance between contour lines. A contour map has many 

lines on it. Those lines are never crossing to each other and each line has a unique 

elevation value that defines its elevation on the map. Contour interval defines 

height interval between the lines. 
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4.3.6. RELIEF 

Relief (or local relief) refers specifically to the quantitative measurement of 

vertical elevation change in a landscape. It is the difference between 

maximum and minimum elevations within a given area, usually of limited 

extent. Relief is essentially the opposite of "flatness". It is the difference in 

height between the high point and the low point on a landscape, in feet or in 

meters. Various features like mountains, hills, plateaus and plains are found 

on the earth's surface. Elevations and depressions on the earth's surface are 

known as the relief features of earth. Creates a shaded relief layer from digital 

elevation data. You can specify the relief color manually, or you can let the 

algorithm choose automatically all the relief classes. 

Parameters 

Label Name Type Description 

Elevation 

layer 
INPUT  [raster] 

Digital Terrain 

Model raster 

layer 

Z factor 
Z_FACTO

R  

[number] 

Default: 1.0 

Vertical 

exaggeration. 

This parameter is 

useful when the 

Z units differ 

from the X and Y 

units, for 

example feet and 

meters. You can 

use this 

parameter to 

adjust for this. 

Increasing the 

value of this 

parameter will 

exaggerate the 

final result 
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Label Name Type Description 

(making it look 

more “hilly”). 

The default is 1 

(no 

exaggeration). 

Generate 

relief 

classes 

automati

cally 

AUTO_CO

LORS  

[boolean] 

Default: False 

If you check this 

option the 

algorithm will 

create all the 

relief color 

classes 

automatically 

Relief 

colors 

Optional 

COLORS  [table widget] 

Use the table 

widget if you 

want to choose 

the relief colors 

manually. You 

can add as many 

color classes as 

you want: for 

each class you 

can choose the 

lower and upper 

bound and finally 

by clicking on 

the color row you 

can choose the 

color thanks to 

the color widget. 

 

Manually setting 

of relief color 
classes 
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Label Name Type Description 

The buttons in 

the right side 

panel give you 

the chance to: 

add or remove 

color classes, 

change the order 

of the color 

classes already 

defined, open an 

existing file with 

color classes and 

save the current 

classes as file. 

Relief OUTPUT  

[raster] 

Default: [Save to tempor

ary file]  

Specify the 

output relief 

raster layer. One 

of: 

 Save to a 

Temporary 

Layer 

( TEMPORARY

_OUTPUT ) 

 Save to File… 

The file encoding 

can also be 

changed here. 
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5. RESULT AND DISCUSSION 

With the help of DEM image from Bhuvan we worked on creating different 

features such as aspect, hill shade, slope, sieve, relief and contour of Tuticorin 

Taluk.   

5.1. CALCULATING the terrain analysis 

features 

5.1.1. Aspect 

We obtained aspect of Tuticorin district by the following methods: 

 Raster > Analysis > Aspect 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to aspect.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called aspect. 

 We changed the symbology of the original DEM to use 

the pseudocolour scheme  

 Hid all the layers except the DEM and aspect layers. 

 Clicked and dragged the DEM to be beneath the aspect layer in the Layers 

list. 

 We set the aspect layer to be transparent by opening its Layer properties and 

we set the transparency to 0% 

 View > New 3D Map View 

 In scene setting, we had set the z-exaggeration to 50     

 We got the result like this: 
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5.1.2. Hill shade  

We obtained hill shade of Tuticorin district by the following methods: 

 Raster > Analysis > Hill shade 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to hillshade.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called hill shade. 

 We changed the symbology of the original DEM to use 

the pseudocolour scheme  

 Hid all the layers except the DEM and hill shade layers. 

 Clicked and dragged the DEM to be beneath the hill shade layer in 

the Layers list. 

 We set the hill shade layer to be transparent by opening its Layer properties 

and we set the transparency to 0% 

 View > New 3D Map View 
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 In scene setting, we had set the z-exaggeration to 50     

 We got the result like this: 

 

 

 

5.1.3. SLOPE 

We obtained the slope of Tuticorin district by the following methods: 

 Raster > Analysis > Slope 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to slope.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called slope. 

 We changed the symbology of the original DEM to use 

the pseudocolour scheme  

 We set the slope layer to be transparent by opening its Layer properties and 

we set the transparency to 0% 
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 View > New 3D Map View 

 In scene setting, we had set the z-exaggeration to 50     

 We got the result like this: 

 

 

  

5.1. 4. Sieve  

We obtained the sieve of Tuticorin district by the following methods: 

 Raster > Analysis > Sieve 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to sieve.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called sieve. 

 We changed the symbology of the original DEM to use 

the pseudocolour scheme  

 We set the sieve layer to be transparent by opening its Layer properties and 

we set the transparency to 0% 

 View > New 3D Map View 
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 In scene setting, we had set the z-exaggeration to 50     

 We got the result like this: 

 

 

 

5.1.5. Contour 

We obtained the contour of Tuticorin district by the following methods: 

 Raster > Analysis > Contour 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to contour.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called contour. 

 We changed the symbology of the original DEM to use 

the pseudocolour scheme  

 We set the contour layer to be transparent by opening its Layer properties 

and we set the transparency to 0% 

 We got the result like this: 
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RELIEF 

We obtained the relief of Tuticorin district by the following methods: 

 Raster > Analysis > Relief 

 In the dialog that appeared, we ensured that the input file was DEM layer. 

 We have set the output file to relief.tif in the directory exercise _ data / 

residential _ development.   

 When the processing was complete we got a new layer called relief. 

 We got the result like this: 
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5.2. APPLICATION  

 

 Covid case table 

 

Here are the ten states with the highest daily spikes in Covid-19 cases in 

India: 

 

 

 

State Positive 

cases 

Maharashtra 66,191 

Uttar Pradesh 35,311 
 

Karnataka 34,804 

Kerala 28,469 
 

Delhi 22,933 

West Bengal 15,889 
 

Rajasthan 15,809 

Tamil Nadu 15,659 

Gujarat 14,296 

Madhya Pradesh 13,601 
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 Geographic information science (GIS) has established itself as a distinct 

domain and incredibly useful whenever the research is related to geography, 

space, and other spatio-temporal dimensions. However, the scientific 

landscape on the integration of GIS in COVID-related studies is largely 

unknown. In this systematic review, we assessed the current evidence on the 

implementation of GIS and other geospatial tools in the COVID-19 pandemic. 

 Understanding the spatiotemporal dynamics of COVID-19 is essential for its 

mitigation, as it helps to clarify the extent and impact of the pandemic and can 

aid decision making, planning and community action. We obtained the 

COVID_19 affected total case strategies in India from Wikipedia and organized 

the data in the excel sheet. The sheet is saved in the CVS data format. In the 

QGIS software, the vector layer downloaded from DIVAGIS is used.  

 Layer > Data Source Manager > Delimited Text > Add CSV file  

1. geometry definition – no geometry  

 Layer panel > Cases Layer > properties > Joints > Add New Joint.  

 Join layer – Cases, join field – state, target field – state in vector layer > 

apply. 

 The cases are added to the attribute table of the vector layer.  

 The vector layer is exported to make it as the permanent layer.  

 To categories the Covid case, properties > symboloy > categorized > 

value – cases > apply.  

 Properties > label > single label. 

 We got the result like this  
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 The interdisciplinary nature of how geographic and spatial analysis was 

used in COVID-19 research was notable. This application not only provided 

an overarching view on how GIS has been used in COVID-19 research so 

far but also concluded that geospatial analysis and technologies could be 

used in future public health emergencies along with statistical and other 

socio-economic modeling techniques. Our review also highlighted how 

scientific communities and policymakers could leverage GIS to extract 

useful information to make an informed decision in the future. Despite the 

limited applications of GIS in identifying the nature and spatio-temporal 

pattern of this raging pandemic, there are opportunities to utilize these 

techniques in handling the pandemic. The use of spatial analysis and GIS 

could significantly improve how we can understand the pandemic as well as 

address the underserviced demographic groups and communities. 
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6. CONCLUSION 

 

Remote sensing and Terrain analysis using Quantum GIS 

techniques is a powerful tool for mapping and evaluating different 

features of land. We created different features of Tuticorin Taluk 

such as aspect, hill shade, slope, sieve, contour and relief from the 

DEM images downloaded from Bhuvan. This study classifies 

terrain features of Tuticorin using DEM from Bhuvan website 

through Quantum Digital Elevation Model. We obtained 3D 

model of all the terrain features from the study. This study is 

useful because it can handle the complexity of individual 

landscape processes and patterns as well as some of the difficulties 

that are encountered in delineating the appropriate spatial and 

temporal scales. This application not only provided an overarching 

view on how GIS has been used in COVID-19 research so far but 

also concluded that geospatial analysis and technologies could be 

used in future public health emergencies along with statistical and 

other socio-economic modeling techniques. Our review also 

highlighted how scientific communities and policymakers could 

leverage GIS to extract useful information to make an informed 

decision in the future. Despite the limited applications of GIS in 

identifying the nature and spatio-temporal pattern of this raging 

pandemic, there are opportunities to utilize these techniques in 

handling the pandemic.  This study may help the Government to 

evaluate the total cases and can keep the pandemic situation under 

control.  
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